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A usability test of MedInformatix EHR V7.7, an ambulatory electronic health record software from 
MedInformatix Inc., was conducted on three different studies (phases) during the time of November-
December 2017, February-March 2018 and October 2018 in the Los Angeles, CA office by MedInformatix 
product group.  
The purpose of this summative study was to test and validate the usability of the current user interface 
and provide evidence of usability of MedInformatix Complete EHR V7.7 in the EHR Under Test (EHRUT). 
 
This report includes separate documentation of the three phases conducted of usability testing.  Overall 
the 3 studies collected performance data on 48 tasks typically conducted on an EHR. The tasks created 
are associated to the twelve (12) certification criteria identified in 45 CFR Part 170 Subpart C of the 
Health Information Technology: 2015 Edition Health Information Technology (Health IT) Certification 
Criteria: 
 
 170.315(a)(1) Computerized Provider Order Entry - Medications 
 170.315(a)(2) Computerized Provider Order Entry - Laboratory 
 170.315(a)(3) Computerized Provider Order Entry – Diagnostic Imaging 
 170.315(a)(4) Drug-Drug, Drug-Allergy Interactions Checks 
 170.315(a)(5)    Demographics 
 170.315(a)(6) Problem List 
 170.315(a)(7) Medication List 
 170.315(a)(8) Medication Allergy List 
 170.315(a)(9) Clinical Decision Support 
 170.315(a)(14)  Implantable device List 
 170.315(b)(2) Clinical Information Reconciliation and Incorporation 
 170.315(b)(3) Electronic Prescribing 
 
Table A. Summary of the results from the 3-different studies 

UCD Phase Phase 1 Phase 2 Phase 3 Average 

System-Usability 

Scale (SUS) 

84.8 87 91 87.6% 

Task Success 93.06 94 98 95% 

Task Confidence 4.6 4.79 4.87 4.75% 

 
System Usability Scale (SUS) scored the subjective satisfaction with the system based on performance 
with these tasks. Results of the study indicated that the MedInformatix EHR system was quite 
satisfactory with regards to effectiveness and efficiency. The participants were very successful in 
completing all tasks and very confident in the ease and use of the system.  
 
Results are detailed in each of the 3 UCD Phases documents of this report, which includes a subsection 
for each of the ONC CEHRT 2015 Edition criteria.  
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EXECUTIVE SUMMARY 
 
A usability test of MedInformatix EHR V7.7, an ambulatory electronic health record software from 
MedInformatix Inc., was conducted on November 1, 2017 through December 16, 2017 in the Los Angeles, CA 
office by MedInformatix product group over remote tele-conferencing sessions using GoToMeeting.  
The purpose of this summative study was to test and validate the usability of the current user interface and 
provide evidence of usability of MedInformatix Complete EHR V7.7 in the EHR Under Test (EHRUT). 
 
During the usability test, ten (10) healthcare providers and/or other intended users matching the target 
demographic criteria served as participants and used the EHRUT in simulated, but representative tasks. 
This study collected performance data on 17 tasks typically conducted on an EHR. The tasks created are 
associated to five (5) of the twelve (12) certification criteria identified in 45 CFR Part 170 Subpart C of the Health 
Information Technology: 2015 Edition Health Information Technology (Health IT) Certification Criteria: 
 
 170.315(a)(1) Computerized Provider Order Entry - Medications 
 170.315(a)(4) Drug-Drug, Drug-Allergy Interactions Checks 
 170.315(a)(5)    Demographics 
 170.315(a)(7) Medication List 
 170.315(a)(8) Medication Allergy List 
  
 
During the 90 minutes, one-on-one usability test, each participant was greeted by the administrator and asked 
to review and sign an informed consent/release form (included in Appendix 3); they were instructed that they 
could withdraw at any time. All participants were current users of MedInformatix EHR, so they had prior 
experience with some version of the EHR. The administrator introduced the test and instructed participants to 
complete a series of tasks (given one at a time) using the EHRUT. During the testing, the administrator timed the 
test and, along with the data logger(s) recorded user performance data on paper and electronically. The 
administrator did not give the participant assistance in how to complete the task. 
 
Participant screens and audio were recorded for subsequent analysis. The following types of data were collected 
for each participant: 

• Number of tasks successfully completed within the allotted time without assistance 
• Time to complete the tasks 
• Number and types of errors 
• Path deviations 
• Participant’s verbalizations 
• System Usability Scale (SUS) 

 
All participant data was de-identified – no correspondence could be made from the identity of the participant to 
the data collected.  
 
Following the conclusion of the testing, participants were asked to complete a post-test questionnaire but were 
not compensated.  
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The UCD process used in the design and development of the above five 2015 Edition Certification criteria was 
based on NISTIR 7741. Various recommended metrics, in accordance with the examples set forth in the NIST 
Guide to the Processes Approach for Improving the Usability of Electronic Health Records, were used to 
evaluate the usability of the EHRUT.  
 
The results from the System Usability Scale (SUS) scored the subjective satisfaction with the system based on 
performance with these tasks to be: 84.8 %. Results of the study indicated that the MedInformatix EHR system 
was quite satisfactory with regards to effectiveness and efficiency. The average Confidence/Ease ratings was 4.6 
out of 5 when asked “How confident/easy was it to use the product being tested to complete the given task:” on 
a scale of 1 (Very Difficult) to 5 (Very Easy). The participants were very satisfied with the system. Results are 
detailed in the Results section of this report, which includes a subsection for each of the five ONC CEHRT 2015 
Edition criteria.  
 
In addition, to the performance data, the following qualitative observations were made: 
 
 
MAJOR FINDINGS 

• Users who did not routinely perform a task as part of their every day job function could navigate and 
perform each task easily. 

• Areas with new functionality were introduced to users prior to the task and no major problems were 
observed. 

• Based on feedback, users appear satisfied with the design, and found the interaction uncomplicated and 
easy to complete. 

• Users were highly effective and efficient in completing the tasks except those that didn’t follow task 
instructions closely or encountered technical difficulties outside of our control. 

• MedInformatix EHR V7.7 is a highly usable system with a relatively short learning curve. 
• Very high mean successful task completion rate with overall average of 93% indicating that in general 

the participants had little or no difficulty completing the tasks.  
• In general participants completed the tasks within an acceptable time. Some tasks were completed 

below the calculated optimal time or the same as the optimal time, while other few tasks took slightly 
longer than expected.  

• Tasks that took the longest time required more steps/clicks and navigation to an unfamiliar portion of 
the screen. 

• Some participants experienced minor deviations when attempting to perform their assigned task, this 
also contributed to exceeding optimal time. 
 

 
AREAS FOR IMPROVEMENT 

• No major areas of improvement were noted. 
• Minor adjustments to enhance search results and make it easier to navigate and select the correct 

option.  
• Consider button placement for ease of use. 

• Indication of Required Fields – Provide a clear indication of required fields. 
• Workflow indication – Provide users with visual and/or functional guidance by greying out and disabling 

features that are inappropriate for the task being performed.   
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INTRODUCTION 
 
The EHRUT tested for this study was MedInformatix EHR - V7.7.  
Designed to present medical information to healthcare providers in radiology and ambulatory settings, the 
EHRUT consists of Practice Management/Scheduling, Billing, and EHR functionality.  The usability testing 
attempted to represent realistic exercises and conditions. 
 
The purpose of this study was to test and validate the usability of the MedInformatix EHR V7.7 user interface 
and provide evidence of usability in the EHR Under Test (EHRUT). To this end, measures of effectiveness, 
efficiency and user satisfaction, such as ease of use and completion of task in a timely manner were captured 
during the usability testing. Satisfaction and user confidence was assessed using the System Usability Scale (SUS) 
satisfaction questionnaire and the post-task Confidence rating question. 
 
The design is based upon an explicit understanding of users, tasks and environments. Medlnformatix considers 
the context always - the exam room, the patient interaction, the difference scenarios faced both by the clinician 
and the back office or front desk staff- when designing and enhancing the software. Context was carefully 
considered in the User Centered Design testing, and Medlnformatix observes users in the field on a regular 
basis. 
 
Users are involved throughout design and development of the process, in initial needs assessment, 
conceptualization and specifications. Medlnformatix solicits user feedback early in the process using a Client 
Advisory Board, User Group Meetings, contact with individual clients, client visits, and industry trade shows and 
events. Users are involved throughout, through prototyping and beta-testing, then after release through 
enhancement requests. 
 
Agile development allows Medlnformatix to make changes throughout the process making it iterative. 
 

 

METHOD 
 
PARTICIPANTS 
 
A total of 10 participants were tested on MedInformatix EHR V7.7. Participants in the test were physicians, 
nurses, and other healthcare assistants in ambulatory and radiology settings, ranging in years of experience 
with MedInformatix (MI).  MedInformatix Product Team analysts coordinated the recruitment of participants.  
 
For the test purposes, end-user characteristics were identified and translated into recruitment screener used 
to solicit potential participants; an example of a screener is provided in Appendix 1 – Sample Participant 
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Recruitment screener. The recruiting process for participants identified known MedInformatix users of various 
geographic areas and demographics, targeting a cross-section of the population based on diversification of job 
role and length of experience with MedInformatix. The participants were contacted and scheduled via email, or 
telephone and confirmed for their testing session. 
 
Participants had no direct connection to the development organization producing the MedInformatix EHR 
system. Participants were not from the testing or supplier organization. For new features being tested, each 
participant was given a 30-minute online training session prior to the study. This training was specifically 
developed and designed to introduce the MedInformatix EHR V7.7 technology, features and benefits being 
tested during this study. 
 
 
The following Table 1: Participants lists participants by characteristics, including demographics, professional 
experience, computing experience, product experience and user needs for assistive technology. Participant 
names were replaced with Participant IDs so that an individual’s data cannot be tied back to individual 
identities. 

 
   
 

Table 1: Participants  
 
  

Part 
ID 

  
Gender 

 

Age 

 

Education 

 
Occupation/ role 

 
Professional 
Experience 
(months) 

 
Computer 
Experience 
(months) 

 
Product 
Experience 
(months) 

Assistive 
Technology 

Needs 

1 ID01 F 30-39 Master’s 
Degree 

Nurse Practitioner 156 252 36 No 

2 ID02 F 30-39 Associate 
Degree 

Operations Manager 156 204 120 No 

3 ID03 F 30-39 Associate 
Degree 

Nurse 168 200 168 No 

4 ID04 F 50-59 Doctorate 
Degree 

Physician 252 240 194 No 

5 ID05 F 50-59 Bachelor’s 
Degree 

Project Manager 444 260 86 No 

6 ID06 F 30-39 Master’s 
Degree 

Nurse Practitioner 96 240 132 No 

7 ID07 F 40-49 Bachelor’s 
Degree 

Network 
Administrator 

288 312 216 No 

8 ID08 F 50-59 Associate 
Degree 

Tech Manager 432 240 240 No 

9 ID09 F 30-39 Bachelor’s 
Degree 

IT Analyst 120 60 60 No 

10 ID10 F 30-39 Bachelor’s 
Degree 

IT Director 87 147 87 No 
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10 participants (matching the demographics in the section on Participants) were recruited and 10 participated in 
the usability test. 0 participants failed to show for the study. 
 
Participants were scheduled for 60-minute sessions with 30 minutes prior to each session for debrief by the 
administrator(s)/data logger(s), and to reset systems to proper test conditions. A spreadsheet was used to keep 
track of the participant schedule and included each participant’s demographic characteristics as provided by the 
recruiting team. 
 
Those who responded to the invitation to take part in the study were sent documentation ahead of time with 
participants instructions(tasks), and a questionnaire that served as the participant screener. 
 
Summary of Participant Characteristics: 

 
Participants had experience with the occupation and expertise that aligns with the capability under testing. The 
users selected as participants was varied and was not limited to clinicians. The demographic characteristics of 
the test participant reflected the audience of current and future users. 
 
Table 2: Summary of Participants 
 

Gender  
Female 10 
Male 0 
  
Age Range  
30 to 39 6 
40 to 49 1 
50 to 59 3 
  
Education  
Some college credit, no degree 0 
Trade technical vocational training 0 
Associate degree 3 
Bachelor’s degree 4 
Master’s degree 2 
Doctorate degree 1 
  
Years of Experience with EHRUT  
None 0 
Up to 3 years 0 
3 - 5 years 2 
5 – 10 years 2 
10 – 15 years 3 
15 – 20 years 3 



Version 7.7 Page 8 of 37 

F    
 
 
 
 

8 | EHR Usability Test Report of MedInformatix EHR V7.7 
 

 
 
 
STUDY DESIGN 
 

Overall, the objective of this test was to discover areas where the MedInformatix EHR application performed 
well – that is, effectively, efficiently, and with satisfaction – and areas where it did not meet the needs of the 
users.  The data from this test may serve as a baseline for future tests of updated versions of MedInformatix 
EHR and/or for comparison with other EHRs provided the same tasks are used. In short, this testing serves as 
both a means to record or benchmark current usability, but also to identify areas where improvements must  
be made. 
 
During the usability test, each participant interacted with MedInformatix EHR V7.7. Each participant used the 
system and was provided with the same instructions during individual 60-90-minute GoToMeeting sessions. 
 
MedInformatix EHR V7.7 was evaluated for effectiveness, efficiency and satisfaction as defined by measures 
collected and analyzed for each participant: 
 

• Number of tasks successfully completed within the allotted time without assistance 
• Time to complete the tasks 
• Number and types of errors 
• Path deviations 
• Participant’s verbalizations (comments) 
• Participant’s satisfaction ratings of the system 

 
Additional information about the various measures can be found in the Usability Metrics section of this report. 
 

 
TASKS 

 
Seventeen (17) tasks were constructed that would be realistic and representative of the kinds of activities a user 
might perform with MedInformatix EHR V7.7. The tasks were selected based on five ONC CEHRT2015 
certification criteria, taking into consideration their frequency of use, criticality of function, potential for risk to 
patient safety, and those that may be most troublesome for users.  For Task risk ranking see Table 3. The Safety-
Enhanced Design [SED] tasks for the five ONC CEHRT2015 certification criteria included: 
 
CPOE Medications 170.315.a.1 
 

1. Record (enter) medications using Computerized Provider Order Entry 
2. Edit (change) Medications using Computerized Provider Order Entry 
3. Display Changed Computerized Provider Order Entry medication order 
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Drug-drug, Drug-Allergy Interaction Checks 170.315.a.4 
 

4. Using CPOE, trigger a drug-drug interaction by entering a new medication order 
5. Adjust the severity level of a displayed drug-drug interaction 
6. Trigger a drug-allergy interaction by entering a new medication order 

 
 
Demographics 170.315.a.5 
 

7. New patient entry, record a patient’s preferred language, date of birth, birth sex, race, ethnicity, sexual 
orientation, and gender identity 

8. Modify a patient’s attribute such as preferred language, date of birth, birth sex, race, ethnicity, sexual 
orientation, and gender identity  

9. Display change made in patient’s demographics 
 
 
Medication List 170.315.a.7 
 

10. Record a medication to the medication list 
11. Change a medication on the medication list 
12. Display the active medication list 
13. Display the historical medication list 

 
Medication Allergy List 170.315.a.8 
 

14. Record a medication allergy  
15. Change a medication allergy  
16. Display the active medication allergy list 
17. Display the historical medication allergy list 
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A summary of the User Tasks prioritization ranking based on the Risk associated with user errors and patient 
safety is shown in Table 3. 
 
Table 3: Task Risk Ranking Pre-& Post test 

Measure/Task  Risk  Pre-Reason for Risk  Post Risk Observations  
CPOE Medication 170.315.a.1        
Current meds entered  6  User can enter the wrong Med 

or be in the wrong chart  
No error observed during testing.    

Edit Medications   6  User could be in wrong chart  No error observed during testing.  
Display Changed Medication  7  Very Low risk because of low 

probability of human error  
No error observed during testing.  

Drug-(Drug/Allergy) Interaction Checks 
170.315.a.4  

      

Using CPOE, trigger a drug-drug interaction by 
entering a new medication order  

6  User may have an incomplete 
list  

1 instance failed due to connectivity 
with 3rd party. Rare instance.  

Adjust the severity level of a displayed drug-
drug interaction  

6  User may set severity level too 
high  

No error observed during testing.  

Trigger Drug-allergy  6  Allergy must be present before 
drug selection  

No error observed during testing.  

Demographics 170.315.a.5        
New patient Entry  5  User may inject typos in the 

process  
No error observed during testing.  

Modify a patient’s selection   6  User may inject typos in the 
process  

No error observed during testing.  

Display change in Demographics  7  Very Low risk because of low 
probability of human error  

No error observed during testing.  

Medication List 170.315.a.7        
Record a medication to the medication list  6  User can enter the wrong Med 

or be in the wrong chart  
No error observed during testing.  

Change a medication on the medication list  6  User could be in wrong chart  No error observed during testing.  
Display the active medication list  7  Very Low risk because of low 

probability of human error  
No error observed during testing.  

Display the historical medication list  7  Very Low risk because of low 
probability of human error  

No error observed during testing.  

Medication Allergy List 170.315.a.8        
Record a medication allergy   6  Patient may not have 

knowledge of allergies  
No error observed during testing.  

Change a medication allergy   7  Very Low risk because of low 
probability of human error  

No error observed during testing.  

Display the active medication allergy list  7  Very Low risk because of low 
probability of human error  

No error observed during testing.  

Display the historical medication allergy list  7  Very Low risk because of low 
probability of human error  

No error observed during testing.  

Risk Probability Key        
1 - Very High Risk     

Note: Users usage did not demonstrate an increase in potential risk to 
patients. 

 
2 - High Risk         
3 - Moderate-High Risk        
4 - Moderate Risk         
5 - Moderate-Low Risk        
6 - Low Risk         
7 - Very Low Risk         
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PROCEDURES 

 
Upon starting the remote connection, GoToMeeting session, the participant was greeted; their identity was 
verified and matched with a name on the participant schedule. Each participant read and agreed to a recording 
consent and signed a non-disclosure agreement and informed consent form (See Appendix 3). The administrator 
from the test team witnessed the participant’s acknowledgement and acceptance. Some sessions were 
recorded for quality purposes and analysis. 
 
The usability testing administrators who conducted the tests were experienced Information Technology and 
Health Information Specialists with 5-15 years of experience with EHRUT, backgrounds in healthcare, health 
information technology and clinical EHR training, implementation and support. 
 
The administrator moderated the session including administering instructions and tasks. The administrator also 
monitored task times, obtained post-task rating data, and took notes on participant comments. They also served 
as the data logger and took notes on task success, path deviations, number and type of errors. 

Participants were instructed to perform the tasks (see specific instructions below): 

• As quickly as possible making as few errors and deviations as possible. 
• Without assistance; administrators could give immaterial guidance and clarification on tasks, but not 

instructions on use. 
• Withholding questions until the end of the test. 

 
For each task, the participants were given a written copy of the task. Task timing began once the administrator 
finished reading the question and indicated to start. The task time was stopped once the participant said, 
“Done,” or otherwise indicated they had successfully completed the task. Scoring is discussed below in the Data 
Scoring section. 
 
Following the session, the administrator gave the participant the post-test questionnaire (e.g., the System 
Usability Scale, see Appendix 5), and thanked them for their participation.  
 
Participants' demographic information, task success rate, time on task, errors, deviations, verbal responses, and 
post-test questionnaire were recorded into a spreadsheet. 

 
TEST LOCATION 
 

All participants were tested on the MedInformatix EHR V7.7 system during remote 
conferencing sessions using GoToMeeting. The test participants used their own computer terminals that could 
connect to the Internet with a GoToMeeting session. Participants were located at their place of employment, to 
ensure maximum comfort in their usual work environment. The environment was verified as comfortable for 
users, noise levels were kept to a minimum with the ambient temperature within a normal range. 
 
During a given GoToMeeting session, only the test administrator and participant communicated with one 
another. The GoToMeeting usability test session was conducted by a test administrator from MedInformatix 
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Product team working from their office or a small conference room. The test administrator accessed and 
observed the completion of tasks via remote access to the participants terminal.  During a session, only the test 
administrator could see the participant’s screen and hear the participant’s comments, questions, and responses. 

 
TEST ENVIRONMENT 

The EHRUT would typically be used in an ambulatory healthcare setting. In this instance, testing of the 
MedInformatix EHR V7.7 system was conducted via remote connection during individual GoToMeeting sessions. 
Each participant was sent a GoToMeeting invitation for their specific testing session.  

 

For testing, the computer used a Windows 2016 Data Center running OS 64-bit Intel ® Xeon ® 2.4 GHZ. The 
MedInformatix EHR V7.7 application was set up by the vendor according to MedInformatix documentation 
describing the system set-up and preparation. The application itself ran on a client/server platform using a 
sample test database set up specifically for the test on a WAN connection. Participants used their keyboard and 
mouse when interacting with the EHRUT and logged in directly to the application to perform the tasks. The 
application was set to default system preferences. 

Technically, the system performance (i.e., response time) was representative to what actual users would 
experience in a field implementation. Additionally, participants did not change any of the default system 
settings (such as control of font size). 

 
 
TEST FORMS AND TOOLS 

 
During the usability test, various documents and instruments were used, including: 

• Participant Recruiting Screener 

• Recording Consent Form 

• Informed Consent 

• Facilitator’s Guide 

• Tasks 

• Post-test Questionnaire 

• Task Confidence Questionnaire 

• Datalogger Spreadsheet 

Examples of some of these documents can be found in Appendices 1-6 respectively. Participants’ interaction 
with MedInformatix EHR V7.7 was captured and recorded digitally using GoToMeeting software running on the 
test administrator’s workstation. Verbal responses were recorded through GoToMeeting recording software 
(microphone integrated into the participant’s computer or through a telephone connection).  

The participant’s interaction with the EHRUT was captured and recorded digitally with screen capture software 
running on the administrator’s machine.  
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PARTICIPANT INSTRUCTIONS 

 

 

The administrator reads the following instructions aloud to the participant (also see the full 
facilitator’s guide in Appendix [4]. 

Thank you for participating in this study. Our session today will last 60-90 minutes. During that time, you will 
look at MedInformatix V7.7 electronic health record system. 

I will ask you to complete a few tasks using this system and answer some questions. We are interested in how 
easy (or how difficult) this system is to use, what in it would be useful to you, and how we could improve it. You 
will be asked to complete these tasks on your own trying to do them as quickly as possible with the fewest 
possible errors or deviations. Do not do anything more than asked. If you get lost or have difficulty I will provide 
minimal assistance with anything to do with the system itself. Please save your detailed comments until the end 
of a task or the end of the session when we can discuss freely. I did not have any involvement in its creation, so 
please be honest with your opinions.  

The product you will be using today is currently in development. Some of the screens or functionality may or may 
not be new to you. 

We are recording the audio and screenshots of our session today. All the information that you provide will be 
kept confidential and your name will not be associated with your comments at any time. Should you feel it 
necessary you are able to withdraw at any time during the testing. 

Do you have any questions or concerns? 

Following the procedural instructions, participants were shown the EHR and as their first task, were given time 
(5 minutes) to ask questions and/or make comments. Once this task was complete, the administrator gave the 
following instructions: 

For each task, I will read the description to you and say “Begin.” At that point, please perform the task and say “Done” once 
you believe you have successfully completed the task. I would like to request that you not talk aloud or verbalize while you are 
doing the task.  I will ask you your impressions about the task once you are done. 

Participants were then given 17 tasks to complete. Tasks are listed in the facilitator’s guide in Appendix [4]. 
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USABILITY METRICS 
 
 
According to the NIST Guide to the Processes Approach for Improving the Usability of Electronic Health Records, 
EHRs should support a process that provides a high level of usability for all users. The goal is for users to interact 
with the system effectively, efficiently, and with an acceptable level of satisfaction. To this end, metrics for 
effectiveness, efficiency and user satisfaction were captured during the usability testing. 

The goals of the test were to assess: 

 

1. Effectiveness of MedInformatix EHR V7.7 by measuring participant success rates and errors 

2. Efficiency of MedInformatix EHR V7.7 by measuring the average task time and path deviations 

3. Satisfaction with MedInformatix EHR V7.7 by measuring ease of use ratings 

 

 

 
  



Version 7.7 Page 15 of 37 

F    
 
 
 
 

15 | EHR Usability Test Report of MedInformatix EHR V7.7 
 

DATA SCORING 
 

The following table (Table 4) details how tasks were scored, errors evaluated, and the time data analyzed. 
      

 Table 4. Details of how observed data were scored. 

Measures Rationale and Scoring 
Effectiveness: 

Task Success 
Task success was determined by assigning numeric weights for various levels of task success, as follows: 
• Easy -Pass (without assistance) = 5  
• Medium -Partial success (minimal assistance) = 3 
• Hard – Partial Success (took longer than expected) = 1 
• Fail – Failure (gave up or failed) = 0 

The results are provided as a percentage. 

 
Effectiveness: 

Task Failures 

If the participant abandoned the task, did not reach the correct answer or performed it incorrectly, or 
reached the end of the allotted time before successful completion, the task was counted as a “Fail.” 
No task times were taken for errors. 

Note: Not all deviations would be counted as errors 

Efficiency: 

Task Deviations 

The participant’s navigation path (i.e., steps) through the application was recorded. Deviations occur 
if the participant, for example, went to a wrong screen, clicked on an incorrect menu item, followed an 
incorrect link, or interacted incorrectly with an on-screen control. This path was compared to the 
optimal path. The number of steps in the observed path is divided by the number of optimal steps to 
provide a ratio of path deviation.  
Path deviations are reported on a qualitative level for use in recommendations for improvement. 

Efficiency: 
Task Time 

Each task was timed from when the administrator said “Begin” until the participant said, “Done.” If 
he or she failed to say “Done,” the time was stopped when the participant stopped performing the 
task. Only task times for tasks that were successfully completed were included in the average task 
time analysis. Average time per task was calculated for each task. Variance measures (standard 
deviation and standard error) were also calculated. 

Satisfaction: 
 
 
Task Rating 
 
 
 
 
 
 
System Satisfaction 

Participant’s subjective impression of the ease of use of the application was measured by 
administering a simple post-task question, a post-task confidence question as well as a post-session 
questionnaire. After each task, the participant was asked to rate “How confident/easy was it to use 
the product being tested to complete the given task:” on a scale of 1(Very Difficult) to 5 (Very Easy). 
These data are averaged across participants. 

Common convention is that average ratings for systems judged easy to use should be 3.3 or above. 

To measure participants’ confidence in and likeability of MedInformatix EHR V7.7 overall, the testing 
team administered the System Usability Scale (SUS) post-test questionnaire.  Questions included, “I 
think I would like to use this system frequently,” “I thought the system was easy to use,” and “I 
would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire in Appendix 5 – System Usability 
Scale Questionnaire.  
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RESULTS 
 

DATA ANALYSIS AND REPORTING 
 

The results of the usability test were calculated and analyzed according to the methods specified in the Usability 
Metrics section above. The usability testing results for MedInformatix EHR V7.7 are detailed in the sections 
below (see Table 5). The results should be seen considering the objectives and goals outlined in Study Design 
section. The data yielded actionable results that, if corrected, yield material, positive impact on user 
performance.   
 

Table 5: Testing Results – Summary of overall task performance 

 
Measure 

 
Task 

 
 

N 

Task 
Success 
% 

Path Deviation 
# of steps 

Task Time - Secs Errors Task Rating 
Avg     7=Easy 

 
# 

Mean SD  Obs./Opt. SD Mean  SD Opt. Mean SD Mean 

 

 

SD 

  1. a.1 Current meds entered – record 
RX 10 100 0 8/8 0 55 18 44 0 0 4.9 0.30 

2. a.1 Edit Medications – Edit RX 10 96 0.6 9/8 0.3 189 34 191 0 0 4.5 0.78 

3. a.1 Display Changed Medication – 
Full RX List 10 88 1.28 11/7 0.84 92 38 180 0 0 4.3 1.00 

4. a.4 Using CPOE, trigger a drug-
drug interaction by entering a new 
medication order – RX trigger 

10 100 0 8/8 0 40 8 36 0 0 4.9 0.30 

5. a.4 Adjust the severity level of a 
displayed drug-drug interaction – 
Severity adj 

10 90 0.47 8/8 0 15 9 12 1 0.3 4.6 0.66 

6. a.4 Trigger Drug-Allergy – Allergy 
Trigger 10 100 0 6/6 0 19 11 12 0 0 4.8 0.40 

7. a.5 New Patient Entry – Record 
Demo 10 88 1.28 11/8 0.46 104 24 99 0 0 4.2 0.87 

8. a.5 Modify a patient’s selection – 
Change Demo 10 96 0.6 9/8 0.3 69 26 54 0 0 4.8 0.60 

9. a.5 Display change in 
Demographics – Display Demo 10 100 0 1/1 0 2 0 2 0 0 5 0 

10. a.7 Record a medication to the 
medication list – Record RX 10 100 0 8/8 0 93 33 81 0 0 4.9 0.30 

11. a.7 Change a medication on the 
medication list – Edit RX 10 92 0.8 10/8 0.4 131 37 105 0 0 4.6 0.66 
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The results from the System Usability Scale (SUS) scored the subjective satisfaction with the system based on 
performance with these tasks to be: 84.8 %.  Broadly interpreted, scores under 60 represent systems with 
poor usability; scores over 80 would be considered above average. Table 5 indicates participant performance in 
the MedInformatix EHR V 7.7 usability test was quite satisfactory. The overall average task completion rate was 
93%. The following charts show details of task performance, task completion, users’ self-rated confidence level 
in using the EHRUT, time spent per task and finally the system satisfaction rating. 
 
 

Chart 1. Task Performance – Shows the % distribution of scored criteria per task 
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Chart 1: Task Performance
TASK 5 6 7 9 10 12 13 14 16 17 18 19 21 22 23 24 25
1-word Record Edit RXFull RX RX trigSeveri  Record Chang  Display Record Edit RXActive Full RX Allergy Allergy Active Full listAllergy Trig
Easy 10 9 8 10 9 7 9 10 10 8 9 10 5 10 4 10 10
Medium 1 1 3 1 2 3 4
Hard 1 1 2 2
Fail 1

12. a.7 Display the active medication 
list – Active RX 10 92 0.8 9/6 0.9 70 36 53 0 0 4.6 0.91 

13. a.7 Display the historical 
medication list – Full RX List 10 100 0 1/1 0 2 0 2 0 0 5 0 

14. a.8 Record a medication allergy – 
Allergy Add 10 72 1.56 18/9 1.13 76 39 44 0 0 3.9 1.04 

15. a.8 Change a medication allergy – 
Allergy Edit 10 100 0 9/9 0 28 8 25 0 0 4.8 0.40 

16. a.8 Display the active medication 
allergy list – Active List 10 68 1.5 19/9 1.09 110 45 98 0 0 3.7 0.98 

17. a.8 Display the historical 
medication allergy list – Full List 10 100 0 1/1 0 2 0 2 0 0 5 0 
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Chart 2. Task Completion – Shows the basic proportion of Successful Tasks / Total Tasks Performed 
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Chart 3. Task Completion & Confidence - Shows the basic proportion of Successful Tasks / Total Tasks 

Performed for each task including Users’ Self-Reported Confidence Ratings re: their successful completion 

of each task 

 

 

Data Chart 3: Task Completion & User Confidence Ratings (Non-adjusted) 

 

 

  

TASK 5 6 7 9 10 12 13 14 16 17 18 19 21 22 23 24 25
1-word Record Edit RXFull RX RX trigSeveri  Record Chang  Display Record Edit RXActive Full RX Allergy Allergy Active Full listAllergy Trig
Successful 1 1 0.9 1 0.9 1 1 1 1 1 0.9 1 0.8 1 0.8 1 1
Conf Rating 0.99 0.93 0.9 0.99 0.93 0.89 0.97 1 0.99 0.94 0.94 1 0.83 0.97 0.8 1 0.97
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Chart 4. Time Spent/Task (Mean w/ Max & Min) 

 

Data Chart 4: Time per Task 

 

 

 

 

  

TASK 5 6 7 9 10 12 13 14 16 17 18 19 21 22 23 24 25
1-word Record Edit RXFull RX RX trigSeveri  Record Chang  Display Record Edit RXActive Full RX Allergy Allergy Active Full listAllergy Trig
Mean 55 189 92 40 15 104 69 2 93 131 70 2 76 28 110 2 19
Max-Mean 36 48 88 16 15 40 71 0 57 77 96 0 51 18 99 0 30
Mean-Min 18 69 35 9 15 41 21 0 48 38 39 0 38 12 55 0 9
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Chart 5. Satisfaction (System Usability Scale) – Shows the total SUS score/100 and a Histogram 

representing the distribution of users’ rating for each item on the questionnaire 

 

SUS Histogram 

 

 
 
 
 
 
 
 
 
 
 

84.8 % SUS Score

System Usability Scale Histogram

1 2 3 4 5
I think I would like to use this software product frequently. ||||

|

||||
|

I found the product unnecessarily complex. ||| ||||
||

|

I thought the product was easy to use. ||||
|

||||
|

I think I would need Tech Support to be able to use this product. ||||
|

||||
|

I found the various functions in this product were well integrated. | |||| ||||
|

I thought there was too much inconsistency in this product. ||| ||||
||

|

I imagine that most people would learn to use this product very quickly. | ||| ||||
||

I found the product very cumbersome to use. |||| ||||
||

I felt very confident using this product. ||||
|

||||
|

I need to learn a lot about this product before I could effectively use it. |||| ||||
|

|

Strongly
Agree

Strongly
Disagree

Item# 1 2 3 4 5 N
1 0 0 0 5 5 10
2 3 6 0 1 0 10
3 0 0 0 5 5 10
4 5 5 0 0 0 10
5 0 0 1 4 5 10
6 3 6 1 0 0 10
7 0 0 1 3 6 10
8 4 6 0 0 0 10
9 0 0 0 5 5 10

10 4 5 1 0 0 10
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DISCUSSION OF THE FINDINGS 
 
In general, the participants performed very well and were satisfied with MedInformatix EHR V7.7 system. Some 
were very impressed with the new features and the improvements from previous version and stated that they 
couldn’t wait to move to this version. There were a few participants that had trouble with some parts of a few 
tasks (took longer time to complete) but in general they were able to successfully complete all the tasks with 
little or no difficulty. Participants performed all tasks on their own with no assistance. They were given a demo 
of new features at the beginning of the test; no external documentation was provided. The average 
performance rate and overall participant satisfaction rates were very high. The MedInformatix EHR V7.7 
system appears to be a highly usable EHR. Below are the individual criteria test findings. 
 
Analysis of the Use, Tested Performance, and Error Rates 
 
Based on the analysis of the data and the observed performance of the participants during testing we did not 
identify any risk prone errors – with a potential likelihood of occurrence and adverse consequences to patients. 
Please see Table 3 For the perceived risk analysis and the post risk results. 
 
CPOE Medication 170.315.a.1 
 
For the Computerized Provider Order Entry Medication criteria our participants engaged in the following tasks: 
 

1. Record (enter) medications using Computerized Provider Order Entry 
2. Edit (change) Medications using Computerized Provider Order Entry 
3. Display Changed Computerized Provider Order Entry medication order 

 
EFFECTIVENESS 
The success score for recording a medication order via CPOE was 100%. However, some of the participants 

faced slight difficulty while displaying the changed medication order. The participants were able to successfully 

record, change and display the changed entries using CPOE, resulting into a success average score of 95%. 

 

EFFICIENCY 
Based on the observations of the task time and deviation data, users could record historical medication history 

and electronically document medication efficiently and quickly and order other tests rapidly. Most of the 

participants outdid the optimal time while performing the tasks, and completed the tasks within the optimal 

number steps, as suggested by the number of steps taken by expert users. We observed one participant going 

over the optimal time and having some deviations because they opted to perform additional steps not required 

by the task. 
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SATISFACTION 
Based on the task ratings and SUS results data, users appear to be satisfied with the design and found the 

interaction to be uncomplicated and easy to complete.  The participants were familiar with these tasks and gave 

an average satisfaction rate of 4.56 out of 5 points. 
 
MAJOR FINDINGS 
 

• The medication-ordering task required searching the drug database and was faster when several 
characters of the medication name were entered in the initial search field. 

• Users could select from a drop-down menu or free-type when entering medication instructions or 
quantity prescribed. 

• The user was required to include relevant details in appropriate fields depending on whether the 
medication was administered onsite, a sample, or by another provider (historical). 

• The medication-ordering task requires searching the drug database and thought must be given to how 
the search is initiated and how the results are displayed. 

• The overall interaction was effective and efficient. 

 
Based on the success, failure and path deviation data, the design of the CPOE functionality appears to be 
effectively designed and configured. Users could easily add and modify historical and new medications. 
Users were able to easily place clinical orders. Overall all our participants found these tasks to be easy, 
effective and had a high confidence rating. The design of the screens required for Electronic Prescribing 
appear to be effective, except for providing clear status of medications- whether they are processed. 
Noticed some slight variation in times due to some participants choosing to add additional information, like 
adding a note about the change, which was beyond task requirements. Some participants indicated they 
would have liked to have more instructions to help with the tasks.  

AREAS FOR IMPROVEMENT 
 

• Look for ways to guide the user through the required steps in the medication-ordering process, i.e., 
after the medication is searched and added, prompt the user to prescribe. 

• Users did not know about the Edit button to edit medications. An improvement was identified to make 
the button stand out more. 

• No areas of improvement for adding medication were noted. 

 

 
Drug-(Drug/Allergy) Interaction Checks 170.315.a.4 
 
Participants were given the following drug-drug, drug-allergy interactions check tasks: 

1. Using CPOE, trigger a drug-drug interaction by entering a new medication order 
2. Adjust the severity level of a displayed drug-drug interaction 
3. Trigger a drug-allergy interaction by entering a new medication order 
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EFFECTIVENESS 
The participants were able to successfully trigger a drug-drug, drug-allergy interaction and adjust the severity 

levels, yielding a task success score of 100%. Only 1 participant couldn’t finish the task, “Adjust the severity level 

of a displayed drug-drug interaction” due to a technology issue outside of their control. 
 
EFFICIENCY 
The participants completed the tasks successfully under optimal time for each task and with either fewer steps 

or the same number of steps as expert users. 
 
SATISFACTION 
For this workflow participants had a satisfaction rating of 5 which is one of the highest scoring areas. The 

participants were familiar with these tasks and found them very easy to use.  

 
MAJOR FINDINGS 
 

• This was an easy task for the users to complete. 
• Users appeared to have no major problems in completing the task. 
• Changing the drug severity notification was new functionality for most users but they were able to 

complete the task in a very efficient manner. 

Given the fact that there were no deviations reported and the task ratings and SUS results data were highly 
scored this was a very easy criterion for our users. The users appeared to be very satisfied with the design 
and found the interaction to be uncomplicated and easy to finish. We did have to report 1 failed task for P8 
because during the test we encountered some technical difficulties that we were unable to resolve so the 
task didn’t get completed. The comments received from our participants echo the conclusion that it was 
easy, effective and efficient process. One participant performed a 3-character search versus performing a 
more specific search which added to load time. 

 
AREAS FOR IMPROVEMENT 
 

Participants provided some recommendations trying to reduce clicks as this task is very click intense. Some 
participants indicated that it would be very nice to have a google like search. See the comments from our 
participants: 

• Would like to "trigger" a search instead of a click 

• Trigger search easier instead of a click 

• Keyboard shortcut – like a “hotkey” 

• Keyboard to trigger the word search 
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• Google like search requested 

• Automatic drop-down 

 
Demographics 170.315.a.5 
 
Participants were given the following demographics tasks to complete: 
 

1. New patient entry, record a patient’s preferred language, date of birth, birth sex, race, ethnicity, sexual 
orientation, and gender identity 

2. Modify a patient’s attribute such as preferred language, date of birth, birth sex, race, ethnicity, sexual 
orientation, and gender identity  

3. Display change made in patient’s demographics 
 

 

EFFECTIVENESS 
All participants were able to enter a new patient and record their demographics as well as edit a patient’s 
demographic information. The task that observed the most deviations (3) was the recording of the demographic 
details, but all participants were able to complete the task. No errors were reported. 
Changing the demographic details came in second with just 1 deviation. The participants were able to 
successfully record, change and display the changed entries made under demographics, resulting into a success 
average score of 95%. 
 
EFFICIENCY 
Of the 10 participants who completed this task, 30% did it under the optimal time, another 30% completed 
these tasks with the same optimal time and 40% exceeded by a small margin the optimal time, as benchmarked 
by expert performance.  
Some of the participants exceeded the optimal time while performing the tasks; however, they completed the 
tasks successfully without any errors.  
 

SATISFACTION 
Participants had an average satisfaction and confidence rating of 4.66 out of 5 points for these tasks.  
Users appear to be satisfied with the design and found the interaction to be uncomplicated and easy to 
complete.   
 
MAJOR FINDINGS 

• This was an easy task for the users to complete. 
• Searching and selecting patient race, ethnicity and gender selections were new lists on a new screen for 

all users. 
• Users had no problems completing the task 

Overall the tasks were easy to complete, and the workflow was efficient. Some minor deviations were observed 
as users were unfamiliar with some of the new screens in Demographics. One of the participants stated that 
changing the DOB felt a little clunky. Most participants did not have any additional suggestions to make but 
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indicated that some of the task instructions could have been clearer. 
 
AREAS FOR IMPROVEMENT 
 

• Search for Common Language does not add to the Common List – Suggested Feature Request 
• No areas of improvement for adding or modifying demographic fields were noted. 

A participant suggested a feature request that when searching for Common Language it should then add it to 

the Common List. This will be taken into consideration as an improvement to the product. In general, there 

were no other recommendations for improvement. 

 
 

Medication List 170.315.a.7 
 

Participants were given four medication list tasks: 
1. Record a medication to the medication list 
2. Change a medication on the medication list 
3. Display the active medication list 
4. Display the historical medication list  

 

EFFECTIVENESS 
 
The average success score for recording a medication to the medication list, changing and displaying the active 
& historical medication list, was 96%. 
All participants successfully accessed their patient’s current medications, reviewed their patient’s previous 
medications and changed an existing medication. 
 
EFFICIENCY 
All participants were able to complete displaying the historical medication list within the optimal time and used 
the same number of steps as the optimal number. However, the participants exceeded the optimal time and 
steps while recording a medication to the medication list. 
Participants completed the tasks of changing a medication on the medication list and displaying the active 
medication list over the optimal time and optimal number of steps. This is most likely due to the high number of 
steps required. 
We observed 2 deviations on changing a medication and observed 3 deviations on displaying the active 
medication list. All other tasks had no deviations observed. 
 
SATISFACTION 
The ease of use and satisfaction for Medication List was very high despite the minor deviations experienced. The 
average satisfaction and confidence rating of 4.78 out of 5 (the easiest) was given to this task. Participants 
indicated that it was easy and intuitive. Most participants were familiar with these tasks and found the tasks 
easy to complete. 
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MAJOR FINDINGS 
 

• There was a high number of steps required to add all medication details, but users could navigate each 
step in a logical order. 

• Search for medications was faster when several characters of the medication name were entered in the 
initial search field. 

• Some users were unfamiliar with the unit conversion when the expected concentration was displayed in 
different units of measure. 

• Some users got a little confused when the name brand name equivalent of a generic medication came 
up in the search when compared to the task instructions which had the generic name. This may have 
caused the exceeded optimal time for tasks 2 & 3. 

• Recording and displaying historical medications list had a high success rate and low failure rate. 
 
The overall interaction was effective and efficient even though two out of the four tasks took longer to execute 
than the optimal expert level benchmark, due to the high number of steps required. Some users were unfamiliar 
with using the screen with medications. Another user was observed adding additional information and taking 
additional steps not required by the task. When users didn’t follow the task instructions correctly deviations and 
exceeding times were observed. 
 
AREAS FOR IMPROVEMENT 
 

• Examine ways to improve the way search results are displayed so that the desired medication is faster 
to select. 

• Look for ways to guide the user through the required steps in the medication-ordering process, i.e., 
after the medication is searched and added, prompt the user to prescribe. 

 
 
 

Medication Allergy List 170.315.a.8 
 
Participants were given four medication allergy list tasks: 

1. Record a medication allergy  
2. Change a medication allergy  
3. Display the active medication allergy list 
4. Display the historical medication allergy list 

 
EFFECTIVENESS 
 
The average success score for recording a medication allergy, changing and displaying the active & historical 
medication allergy list, was 85%. 
All participants successfully accessed their patient’s current medication allergies, reviewed their patient’s 
previous medication allergies and changed an existing medication allergy. Participants had a 100% success rate 
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for changing a medication allergy and displaying the historical medication allergy list. No errors were reported 
but some deviations were observed.  
 
EFFICIENCY 
 
Participants were able to successfully change a medication allergy and display the historical medication allergy 
list under/within the optimal time and optimal number of steps. Participants exceeded the optimal time while 
recording the medication allergy and displaying the active medication allergy list; however, they completed the 
tasks without any errors. This is most likely due to the high number of steps required and number of deviations 
observed. 
 
9 total deviations were observed on recording a medication allergy and 10 deviations on displaying the active 
medication allergy list. All other tasks had no deviations observed. 
 
 
SATISFACTION 
 
The ease of use and satisfaction for Medication Allergy List was high despite the deviations experienced. The 
average satisfaction and confidence rating of 4.3 out of 5 (the easiest) was given to this task. Participants 
indicated that it was easy and intuitive. Most participants were familiar with these tasks and found the tasks 
easy to complete. The reason cited for the lower satisfaction score was “too many clicks”. 
 
MAJOR FINDINGS 
 

• The overall interaction was effective and efficient. 

• There was a high number of steps required to add all medication allergy details, but users could 

navigate each step in a logical order. 

• Search for medications allergy was faster when several characters of the medication name were 

entered in the initial search field. 

The Medication Allergy List tasks, changing a medication allergy and displaying the historical medication 

allergy list scored well in effectiveness, efficiency and satisfaction but recording and displaying the active 

medication allergy list scored a little lower. This suggests that while the tasks work, they could be better 

enhanced for our users. One participant commented that she felt that there was probably and easier way to 

perform the task, but she didn’t know it. 
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AREAS FOR IMPROVEMENT 
 

• No mayor areas for improvement were noted just some recommendations. 

Participants provided the following comments/recommendations to enhance/improve the product: 

- Don’t display inactive allergies in the document.  

- The color “Blue” for inactive meds makes no sense. Nowhere in the screen does it indicate that 

Blue means inactive.  

- A check box at the top for Active Only would help, and if user checks this it should stay on. 
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APPENDICES 
 

Appendix 1: SAMPLE PARTICIPANT RECRUITING SCREENER 
 

At the beginning of each usability test session, the test administrator asked participants the questions on the 
recruiting screener and recorded the responses. 

Participant Questionnaire 
 

1. Date of Testing ____________________ 

2. Participant ID____________________________________________________________ 

3. Description of Intended Users _______________________________________________ 

4. Participant Gender________________________________________________________ 

5. Participant Age___________________________________________________________ 

6. Participant Education______________________________________________________ 

7. Participant Occupation/Role_________________________________________________ 

8. Participant Professional Experience___________________________________________ 

9. Participant Computer Experience_____________________________________________ 

10. Participant Product Experience ______________________________________________ 

11. Does the Participant have any Assistive Technology Needs________________________ 
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Appendix 2: PARTICIPANT DEMOGRAPHICS 
 

Gender  
Female 10 
Male 0 
  
Age Range  
30 to 39 6 
40 to 49 1 
50 to 59 3 
  
Education  
Some college credit, no degree 0 
Trade technical vocational training 0 
Associate degree 3 
Bachelor’s degree 4 
Master’s degree 2 
Doctorate degree 1 
  
Years of Experience with EHRUT  
None 0 
Up to 3 years 0 
3 - 5 years 2 
5 – 10 years 2 
10 – 15 years 3 
15 – 20 years 3 
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Appendix: 3: NON-DISCLOSURE AGREEMENT AND INFORMED CONSENT 
FORM 

NON-DISCLOSURE AGREEMENT AND INFORMED CONSENT FORM  
  

Non-Disclosure Agreement THIS AGREEMENT is entered as of _ _, 2018, between (“the 
Participant”) and the testing organization MedInformatix, Inc. located at Address.  
  
The Participant acknowledges his or her voluntary participation in today’s usability 
study may bring the Participant into possession of Confidential Information. The term 
"Confidential Information" means all technical and commercial information of a 
proprietary or confidential nature which is disclosed by MedInformatix, or otherwise 
acquired by the Participant, during today’s study.  
  
By way of illustration, but not limitation, Confidential Information includes trade 
secrets, processes, formulae, data, know-how, products, designs, drawings, computer 
aided design files and other computer files, computer software, ideas, improvements, 
inventions, training methods and materials, marketing techniques, plans, strategies, 
budgets, financial information, or forecasts.  
  
Any information the Participant acquires relating to this product during this study is 
confidential and proprietary to MedInformatix and is being disclosed solely for the 
purposes of the Participant’s participation in today’s usability study. By signing this 
form, the Participant acknowledges that s/he will not disclose this confidential 
information obtained today to anyone else or any other organizations.  
  
Participant’s printed name:      
  
 
 
Signature:    Date:     
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Appendix 4: EXAMPLE FACILITATOR’S GUIDE 

FACILITATOR’S GUIDE 
Before Recording: 

Thank you for agreeing to participate in this usability study. Our session will last 60-90 minutes. Today you will 

be helping us evaluate workflows pertaining to the 2015 ONC's EHR Vendor Certification requirements. In a 

moment I will be asking you to complete these workflows using MedInformatix EHR V 7.7. I'll be taking notes.  

You have been provided a Participant Guide. This information is available for reference only. I will talk you 

through each step of the process and then ask all the questions. After I have asked the question, you may refer 

to the Participant Guide for more detail. You will be asked to complete these tasks on your own trying to do 

them as quickly as possible with the fewest possible errors or deviations. Do not do anything more than asked. 

Also, I want you to hold your questions, until the end since the tasks are being timed. I would ask to please be 

honest with your opinions. Do you have any questions regarding the documentation provided? 

<Facilitator: If you determine that the Participants questions should be part of the recorded session please have 

them ask it again during the recording. Answer questions and start appropriate demos (PHR etc.).> Before we 

get started I would like to record this session to help me later with my report. Therefore, to help with this data 

collection, we are seeking your verbal consent to record the session <Show consent form> 

Begin Recording: 

<Ask them to please read out loud "I understand that my usability test session will be recorded. I grant 

MedInformatix, Inc. permission to use this recording for internal use only, for improving the products being 

tested." from the consent form.> 

What you will be looking at today is MedInformatix EHR V7.7 populated with a mock patient's information. I will 

ask you to complete a few tasks using this system and answer some questions. please keep in mind that the 

data may not be clinically accurate, and we understand that it may not be applicable to your specialty. We are 

interested in how easy (or how difficult) this system is to use, what in it would be useful to you, and how we 

could improve it.  

I will ask you to start when I say, "BEGIN NOW", and please tell me when you think you've completed the task by 

saying “DONE”. If you feel lost or have difficulty completing the scenario, please continue to try as best as you 

can. If you are unable to complete the task, we will stop the task and move you on to the next task. At the end 

of the session, I will ask you additional questions and there will be a survey. Please understand, we are 

evaluating the ease of use on the software and not your performance on this system.  

 Do you have any questions or concerns? 
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Prior to beginning test – administrator must: 
1. Use the datalogger spreadsheet to record the participant’s experience. 

a. Find the participants identification number and fill out the chart information 
b. Time each task from when the administrator said “Begin” until the participant said, “Done.” Include only 

task times for tasks that were successfully completed in the average task time analysis 
c. Record how many times a task was completed successfully and how many times it was attempted.  
d. Record the path that a participant used to complete the task (count the clicks). Record the difference and 

ratio of the observed path to the optimal path 
e. Record the difference and ratio of the observed time and the optimal time 
f. Count the total number of failed attempts to complete the task (errors), and divide by the total number of 

times that task was attempted 
g. Record task score – Easy – Medium – Hard - Fail 

<BEGIN TEST> 

 
UCD Phase 1 Tasks 

 
Criteria - CPOE Medication 170.315.a.1  

Task 1 – Instruct participant to start the first task, following the ‘A1. Participant Instructions’ document: 
- “In the system, select Jane Doe and enter in the medication list provided below.” 
- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click RX button > Enter 

medication name > Click Search > Select medication and enter sig, this meds etc. > Click Add New (for 
each medication)  

- Optimal Time:    44s 
At the end of this task ask the participant the post-task Confidence rating question.  

Task 2 - Instruct the participant to start the second task, following the ‘A1. Participant Instructions’ document: 
- “In the system, select Jane Doe and enter in the medication list provided below.” 
- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click RX button > Enter 

medication name > Click Search > Select medication and enter sig etc. > Click Add New (for each 
medication) 

- Optimal Time:   191s 

At the end of this task ask the participant the post-task Confidence rating question.  

Task 3 - Instruct the participant to start the third task, following the ‘A1. Participant Instructions’ document. 
- “In the system, select Jane Doe and enter in the medication list provided below.” 
- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click RX button > Select 

medication and sig etc. > Edit medication as listed > Click Save (for each medication) 
- Optimal Time:   180s 

      At the end of this task ask the participant the post-task Confidence rating question. 
 
Criteria - Drug-(Drug/Allergy) Interaction Checks 170.315.a.4 
 

Task 1 – Instruct participant to start the first task, following the ‘A4. Participant Instructions’ document: 
- “In the system, select Jane Doe and enter in the medication list provided below.” 
- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click RX button > Enter 

medication name > Click Search > Select medication and enter sig, this meds etc. > Click Add New (for 
each medication)  
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- Optimal Time:  36s 
At the end of this task ask the participant the post-task Confidence rating question.  

Task 2 - Instruct the participant to start the second task, following the ‘A4. Participant Instructions’ document: 
- “In the system select Jane Doe and access the medication screen. Add medication to trigger Drug 

Severity Notification severity lever is a 2 & 3.” 
- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click RX button > Enter 

medication name > Click Search > Select medication and enter sig etc. > Click Add New (for each 
medication) 

- Optimal Time:   12s 

At the end of this task ask the participant the post-task Confidence rating question.  

Task 3 - Instruct the participant to start the third task, following the ‘A4. Participant Instructions’ document: 
- “In the system select Jane Doe and access the medication screen. Change the Drug Severity Notification 

to only produce an alert if the severity lever is a 1 & 2.  Verify that a level 3 interaction does not appear in 
the Drug Interaction Notification. “ 

- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click RX button > Click Severity Level > 
Change to ‘1 & 2’ >  

- Optimal Time:  12s 
At the end of this task ask the participant the post-task Confidence rating question.  

Criteria - Demographics 170.315.a.5 
Task 1 – Instruct participant to start the first task, following the ‘A5. Participant Instructions’ document: 

- “In the system, select New and enter in the Blue field entries and the items provided on 
Participant Instructions.” 

- Optimal Path: Patient List > New > Auto > Populate Blue field items > Press Select > Search each 
answer if not already in Common list > OK > Save 

- Optimal Time:  99s 
At the end of this task ask the participant the post-task Confidence rating question.  

Task 2 – Instruct participant to start the second task, following the ‘A5. Participant Instructions’ document: 
- “In the system, select ‘TEST, JESS’ patient and change the Blue field entries and the items 

provided on Participant Instructions.” 
- Optimal Path: Patient List > New > Auto > Populate Blue field items > Press Select > Search each 

answer if not already in Common list > OK > Save 
- Optimal Time:  54s 

At the end of this task ask the participant the post-task Confidence rating question.  

Task 3 – Instruct participant to start the third task, following the ‘A5. Participant Instructions’ document: 
- “In the system, select Refresh to Display change in Demographics” 
- Optimal Path: > Press Refresh  
- Optimal Time:  2s 

At the end of this task ask the participant the post-task Confidence rating question.  
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Criteria - Medication List 170.315.a.7 

Task 1 – Instruct participant to start the first task, following the ‘A7. Participant Instructions’ document: 
- “In the system, select Jane Doe and enter in the medication list provided below.” 
- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click RX button > Enter medication 

name > Click Search > Select medication and enter sig etc. > Click Add New (for each medication) 
- Optimal Time:  81s 

At the end of this task ask the participant the post-task Confidence rating question.  

Task 2 – Instruct participant to start the second task, following the ‘A7. Participant Instructions’ document: 
- “In the system select Jane Doe and access the medication screen. Add medication to trigger Drug Severity 

Notification severity lever is a 2 & 3.  

- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click RX button > Enter medication 
name > Click Search > Select medication and enter sig etc. > Click Add New (for each medication) 

- Optimal Time:  105s 

At the end of this task ask the participant the post-task Confidence rating question. 

Task 3 – Instruct participant to start the third task, following the ‘A7. Participant Instructions’ document: 
- “In the system select Jane Doe and access the medication screen. Change the Drug Severity Notification to 

only produce an alert if the severity lever is a 1 & 2.  Verify that a level 3 interaction does not appear in the 
Drug Interaction Notification. “ 

- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click RX button > Click Severity 
Level > Change to ‘1 & 2’ >  

- Optimal Time:  53s 

At the end of this task ask the participant the post-task Confidence rating question.  

Task 4 – Instruct participant to start the fourth task, following the ‘A7. Participant Instructions’ document: 
- “Show entire medication history from medication screen.  
- Optimal Path: de-select “Show Active Items Only” 
- Optimal Time:  2s 

At the end of this task ask the participant the post-task Confidence rating question.  
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Criteria - Medication Allergy List 170.315.a.8 

Task 1 – Instruct participant to start the first task, following the ‘A8. Participant Instructions’ document: 
- “In the system, select Jane Doe and enter in the allergy list provided below.” 
- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click Allergy button > Enter 

medication name > Click drop-down> Select medication > repeat process for reaction > Click Add to 
complete task 

- Optimal Time:  44s 
At the end of this task ask the participant the post-task Confidence rating question.  

Task 2 – Instruct participant to start the second task, following the ‘A8. Participant Instructions’ document: 
- “In the system select Jane Doe and access the allergy screen. Add allergy 
- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click Allergy button > Enter 

medication name > Click drop-down> Select medication > repeat process for reaction > Click Add to 
complete task 

- Optimal Time:  25s 

At the end of this task ask the participant the post-task Confidence rating question. 

Task 3 – Instruct participant to start the third task, following the ‘A8. Participant Instructions’ document: 
- “In the system select Jane Doe and access the Allergy screen. Change the Allergy contents to the 

participation documentation “ 
- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click Allergy button > Delete all 

entries > Enter medication name > Click drop-down> Select medication > repeat process for reaction 
- Optimal Time:  98s 

At the end of this task ask the participant the post-task Confidence rating question.  

Task 4 – Instruct participant to start the fourth task, following the ‘A8. Participant Instructions’ document: 
- “In the system show the complete allergy list “ 
- Optimal Path: “Show All” checkbox >  
- Optimal Time:  2s 

At the end of this task ask the participant the post-task Confidence rating question.  
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Appendix 5: SYSTEM USABILITY SCALE QUESTIONNAIRE 
 

 

 
Participant ID#:______ 
 
These questions will be asked at the end of the testing read and familiarize yourself with them  
 
 
 
                                                               Difficult                                                                                                                Easy  

Overall this task was 
 

                                                            1                 2                3                 4                 5                6                 7                                                          
 
 

 
 
 
 

1. I think that I would like to use 
this system frequently. 

 
2. I found the system unnecessarily 

complex. 
 

3. I thought the system was easy 
to use. 

 
 

4. I think that I would need the 
support of a technical person to 
be able to use this system.  

 
5. I found the various functions 

in this system were well 
integrated.  

 
6. I thought there was too much 

inconsistency in this system.  
 
 

7. I would imagine that most people 
would learn to use this system 
very quickly. 

 
8. I found the system very 

cumbersome to use. 
 
 

9. I felt very confident using the 
system.  

 
10. I needed to learn a lot of 

things before I could get going 
with this system.  

 

Strongly Strongly 
disagree agree 
 
 
 

1 2 3 4 5 
 
 
 

1 2 3 4 5 
 
 
 

1 2 3 4 5 
 
 
 

1 2 3 4 5 
 
 
 
 

1 2 3 4 5 
 
 
 
 
 
1 2 3 4 5 
 
 

 
 

1 2 3 4 5 
 
 

 
1 2 3 4 5 
 
 

 
 
1 2 3 4 5 
 
 

 
 
1 2 3 4 5
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Appendix 6:  RECORD CONSENT FORM 
 

Recording Consent Form 
 

Thank you for participating in our Usability Client Design Testing. 
We will be recording your session to allow MedInformatix, Inc. staff 
members who are unable to be present today to observe your session and 
benefit from your comments. 
 
Please read the statement below and verbally indicate you accept and 
consent. 
 
 
I understand that my usability test session will be recorded. 
I grant MedInformatix, Inc. permission to use this recording for internal use 
only, for improving the products being tested. 
 
Signature               __________________________________________ 
 
Print Name            __________________________________________ 
 
Date Signed           

__________________________________________ 

 



Version 7.7 
 

Page 1 of 38 

F    
 
 
 
 

1 | EHR Usability Test Report of MedInformatix EHR V7.7 
 

 

 

 

 

 

EHR Usability Test Report of MedInformatix EHR V7.7 

Report based on NISTIR 7742 Customized Common Industry Format Template for Electronic Health Record 

Usability Testing 
 

 
 

MedInformatix EHR – V7.7 
 
 
 
 
 
 
 
 
Date of Usability Test: Feb-Mar 2018  
 
Date of Report:            November 2, 2018   
Report Prepared By:   MedInformatix Product Usability Group 
                                       Betty Gomez | Usability Analyst | MedInformatix 
                                       Luis Palacios | Usability Analyst | MedInformatix 
  
    
 
                                       product@medinformatix.com  | 310-766-7430                                                                                                                    
 

5777 West Century Blvd. Suite 1700 Los Angeles CA 90045 
 
 

mailto:product@medinformatix.com


Version 7.7 
 

Page 2 of 38 

F    
 
 
 
 

2 | EHR Usability Test Report of MedInformatix EHR V7.7 
 

Table of Contents 
EXECUTIVE SUMMARY .............................................................................................................................................. 3 
INTRODUCTION ......................................................................................................................................................... 5 
METHOD .................................................................................................................................................................... 5 

PARTICIPANTS ....................................................................................................................................................... 5 

STUDY DESIGN ....................................................................................................................................................... 8 

TASKS ..................................................................................................................................................................... 9 

PROCEDURES ....................................................................................................................................................... 11 

TEST LOCATION ................................................................................................................................................. 122 

TEST ENVIRONMNENT ......................................................................................................................................... 12 

TEST FORMS AND TOOLS .................................................................................................................................... 13 

PARTICIPANT INSTRUCTIONS ............................................................................................................................ 144 

USABILITY METRICS ............................................................................................................................................. 15 

DATA SCORING .................................................................................................................................................... 16 

RESULTS ................................................................................................................................................................. 177 
DATA ANALYSIS AND REPORTING ....................................................................................................................... 17 

DISCUSSION OF THE FINDINGS ............................................................................................................................ 22 

ANALYSIS OF THE USE, TESTED PERFORMANCE, AND ERROR RATES ............................................................. 22 

CPOE LABORATORY 170.315.A.2 ..................................................................................................................... 22 

CPOE DIAGNOSTIC IMAGING 170.315.A.3 ...................................................................................................... 24 

CPOE PROBLEM LIST 170.315.A.6 ................................................................................................................... 25 

CPOE CLINICAL INFORMATION RECONCILIATION AND INCORPORATION 170.315.B.2 .................................. 27 

APPENDICES ............................................................................................................................................................ 28 
Appendix 1: RECRUITING SCREENER ................................................................................................................... 28 

Appendix 2: PARTICIPANT DEMOGRAPHICS ....................................................................................................... 29 

Appendix: 3: NON-DISCLOSURE AGREEMENT AND INFORMED CONSENT FORM .............................................. 30 

Appendix 4: EXAMPLE FACILITATOR’S GUIDE ..................................................................................................... 31 

Appendix 5: SYSTEM USABILITY SCALE QUESTIONNAIRE ................................................................................... 37 

Appendix 6:  RECORDING CONSENT FORM ......................................................................................................... 38 

 



Version 7.7 
 

Page 3 of 38 

F    
 
 
 
 

3 | EHR Usability Test Report of MedInformatix EHR V7.7 
 

EXECUTIVE SUMMARY 
 
A usability test of MedInformatix EHR V7.7, an ambulatory electronic health record software from 
MedInformatix Inc., was conducted on February 16, 2018 through March 28, 2018 in the Los Angeles, CA office 
by MedInformatix product group over remote tele-conferencing sessions using GoToMeeting.  
The purpose of this summative study was to test and validate the usability of the current user interface and 
provide evidence of usability of MedInformatix Complete EHR V7.7 in the EHR Under Test (EHRUT). 
 
During the usability test, ten (10) healthcare providers and/or other intended users matching the target 
demographic criteria served as participants and used the EHRUT in simulated, but representative tasks. 
This study collected performance data on 17 tasks typically conducted on an EHR. The tasks created are 
associated to four (4) of the twelve (12) certification criteria identified in 45 CFR Part 170 Subpart C of the 
Health Information Technology: 2015 Edition Health Information Technology (Health IT) Certification Criteria: 
 
  
 170.315(a)(2) Computerized Provider Order Entry - Laboratory 
 170.315(a)(3) Computerized Provider Order Entry – Diagnostic Imaging 
 170.315(a)(6) Problem List 
 170.315(b)(2) Clinical Information Reconciliation and Incorporation 
  
During the 90 minutes, one-on-one usability test, each participant was greeted by the administrator and asked 
to review and sign an informed consent/release form (included in Appendix 3); they were instructed that they 
could withdraw at any time. All participants were current users of MedInformatix EHR, so they had prior 
experience with some version of the EHR. The administrator introduced the test and instructed participants to 
complete a series of tasks (given one at a time) using the EHRUT. During the testing, the administrator timed the 
test and, along with the data logger(s) recorded user performance data on paper and electronically. The 
administrator did not give the participant assistance in how to complete the task. 
 
Participant screens and audio were recorded for subsequent analysis. The following types of data were collected 
for each participant: 
 

• Number of tasks successfully completed within the allotted time without assistance 
• Time to complete the tasks 
• Number and types of errors 
• Path deviations 
• Participant’s verbalizations 
• System Usability Scale (SUS) 

 
 
All participant data was de-identified – no correspondence could be made from the identity of the participant to 
the data collected.  
 
 
Following the conclusion of the testing, participants were asked to complete a post-test questionnaire but were 
not compensated.  
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The UCD process used in the design and development of the above four 2015 Edition Certification criteria was 
based on NISTIR 7741. Various recommended metrics, in accordance with the examples set forth in the NIST 
Guide to the Processes Approach for Improving the Usability of Electronic Health Records, were used to 
evaluate the usability of the EHRUT.  
 
The results from the System Usability Scale (SUS) scored the subjective satisfaction with the system based on 
performance with these tasks to be: 87%. Results of the study indicated that the MedInformatix EHR system was 
quite satisfactory with regards to effectiveness and efficiency. The average Confidence/Ease ratings was 4.79 
out of 5 when asked “How confident/easy was it to use the product being tested to complete the given task: on 
a scale of 1 (Very Difficult) to 5 (Very Easy)”. The participants were very satisfied with the system. Results are 
detailed in the Results section of this report, which includes a subsection for each of the four ONC CEHRT 2015 
Edition criteria.  
 
In addition, to the performance data, the following qualitative observations were made: 
 
 
MAJOR FINDINGS 

• Users who did not routinely perform a task as part of their every day job function could navigate and 
perform each task easily. 

• Based on feedback, users appear satisfied with the design, and found the interaction uncomplicated and 
easy to complete. 

• Users were highly effective and efficient in completing the tasks except when performing Clinical 
Information Reconciliation, due in part to users’ lack experience with this workflow. 

• Some users closed windows prematurely negating importation of data 
• Very high mean successful task completion rate with overall average of 94% indicating that in general 

the participants had little or no difficulty completing the tasks.  
• In general participants completed the tasks within an acceptable time. Some tasks were completed 

below the calculated optimal time or the same as the optimal time, while other few tasks took slightly 
longer than expected.  

• Tasks that took the longest time required more steps/clicks and navigation to an unfamiliar portion of 
the screen. 

• Some participants experienced minor deviations when attempting to perform their assigned task, this 
also contributed to exceeding optimal time. 

 
AREAS FOR IMPROVEMENT 

• Minor adjustments to enhance search results and make it easier to navigate and select the correct 
option.  

• Consider button placement for ease of use. 
• When user may be leaving the reconciliation without importation provide alert that such action is about 

to happen. 
• Improve the process of accepting changes or updating information. 
• Addition of larger buttons to make the action stand out. 
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INTRODUCTION 
 

The EHRUT tested for this study was MedInformatix EHR - V7.7.  

Designed to present medical information to healthcare providers in radiology and ambulatory settings, the 

EHRUT consists of Practice Management/Scheduling, Billing, and EHR functionality.  The usability testing 

attempted to represent realistic exercises and conditions. 

 

The purpose of this study was to test and validate the usability of the MedInformatix EHR V7.7 user interface 

and provide evidence of usability in the EHR Under Test (EHRUT). To this end, measures of effectiveness, 

efficiency and user satisfaction, such as ease of use and completion of task in a timely manner were captured 

during the usability testing. Satisfaction and user confidence were assessed using the System Usability Scale 

(SUS) satisfaction questionnaire and the post-task Confidence rating question. 

 

METHOD 
 
PARTICIPANTS 
 
A total of 10 participants were tested on MedInformatix EHR V7.7. Participants in the test were physicians, 
nurses, and other healthcare assistants in ambulatory and radiology settings, ranging in years of experience 
with MedInformatix (MI).  MedInformatix Product Team analysts coordinated the recruitment of participants.  
 
For the test purposes, end-user characteristics were identified and translated into recruitment screener used 
to solicit potential participants; an example of a screener is provided in Appendix 1 – Sample Participant 
Recruitment screener. The recruiting process for participants identified known MedInformatix users of various 
geographic areas and demographics, targeting a cross-section of the population based on diversification of job 
role and length of experience with MedInformatix. The participants were contacted and scheduled via email, or 
telephone and confirmed for their testing session. 
 
Participants had no direct connection to the development organization producing the MedInformatix EHR 
system. Participants were not from the testing or supplier organization. For new features being tested, each 
participant was given a 30-minute online training session prior to the study. This training was specifically 
developed and designed to introduce the MedInformatix EHR V7.7 technology, features and benefits being 
tested during this study. 
 
The following Table 1: Participants lists participants by characteristics, including demographics, professional 
experience, computing experience, product experience and user needs for assistive technology. Participant 
names were replaced with Participant IDs so that an individual’s data cannot be tied back to individual 
identities. 
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Table 1: Participants  
 
  

Part 
ID 

  
Gender 

 

Age 

 

Education 

 
Occupation/ role 

 
Professional 
Experience 
(months) 

 
Computer 
Experience 
(months) 

 
Product 
Experience 
(months) 

Assistive 
Technology 

Needs 

1 ID01 F 30-39 Master’s 
Degree 

Nurse Practitioner 156 252 36 No 

2 ID02 F 30-39 Associate 
Degree 

Operations Manager 156 204 120 No 

3 ID03 F 30-39 Associate 
Degree 

Nurse 168 200 168 No 

4 ID04 F 50-59 Doctorate 
Degree 

Physician 252 240 194 No 

5 ID06 F 30-39 Master’s 
Degree 

Nurse Practitioner 96 240 132 No 

6 ID07 F 40-49 Bachelor’s 
Degree 

Network 
Administrator 

288 312 216 No 

7 ID08 F 50-59 Associate 
Degree 

Tech Manager 432 240 240 No 

8 ID11 F 30-39 Bachelor’s 
Degree Office Manager 132 240 54 

No 

9 ID12 F 60-69 Associate 
Degree 

E.H.R. 
Administrator 

264 264 120 
No 

10 ID13 F 40-49 Associate 
Degree 

  
  

  
 

Surgical 
Coordinator 

180 120 120 
No 

 

 
10 participants (matching the demographics in the section on Participants) were recruited and 10 participated in 
the usability test. 0 participants failed to show for the study. 
 
Participants were scheduled for 60-minute sessions with 30 minutes prior to each session for debrief by the 
administrator(s)/data logger(s), and to reset systems to proper test conditions. A spreadsheet was used to keep 
track of the participant schedule and included each participant’s demographic characteristics as provided by the 
recruiting team. 
 
Those who responded to the invitation to take part in the study were sent documentation ahead of time with a 
questionnaire that served as the participant screener. 
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Summary of Participant Characteristics: 
 
Participants had experience with the occupation and expertise that aligns with the capability under testing. The 
users selected as participants was varied and was not limited to clinicians. The demographic characteristics of 
the test participant reflected the audience of current and future users. 
 
 
Table 2: Summary of Participants 
 

Gender  
Female 10 
Male 0 
  
Age Range  
30 to 39 5 
40 to 49 2 
50 to 59 2 
60-69 1 
  
Education  
Some college credit, no degree 0 
Trade technical vocational training 0 
Associate degree 5 
Bachelor’s degree 2 
Master’s degree 2 
Doctorate degree 1 
  
Years of Experience with EHRUT  
None 0 
Up to 3 years 1 
3 - 5 years 1 
5 – 10 years 3 
10 – 15 years 2 
15 – 20 years 3 
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STUDY DESIGN 
 

Overall, the objective of this test was to discover areas where the MedInformatix EHR application performed 
well – that is, effectively, efficiently, and with satisfaction – and areas where it did not meet the needs of the 
users.  The data from this test may serve as a baseline for future tests of updated versions of MedInformatix 
EHR and/or for comparison with other EHRs provided the same tasks are used. In short, this testing serves as 
both a means to record or benchmark current usability, but also to identify areas where improvements must  
be made. 
 
During the usability test, each participant interacted with MedInformatix EHR V7.7. Each participant used the 
system and was provided with the same instructions during individual 60-90-minute GoToMeeting sessions. 
 
MedInformatix EHR V7.7 was evaluated for effectiveness, efficiency and satisfaction as defined by measures 
collected and analyzed for each participant: 
 

• Number of tasks successfully completed within the allotted time without assistance 
• Time to complete the tasks 
• Number and types of errors 
• Path deviations 
• Participant’s verbalizations (comments) 
• Participant’s satisfaction ratings of the system 

 
Additional information about the various measures can be found in the Usability Metrics section of this report. 
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TASKS 
 

Thirteen (13) tasks were constructed that would be realistic and representative of the kinds of activities a user 
might perform with MedInformatix EHR V7.7. The tasks were selected based on four ONC CEHRT2015 
certification criteria, taking into consideration their frequency of use, criticality of function, potential for risk to 
patient safety, and those that may be most troublesome for users.  For Task risk ranking see Table 3. The Safety-
Enhanced Design [SED] tasks for the four ONC CEHRT2015 certification criteria included: 
 

(a.6) Problem List 

1. Record a problem to the problem list 
2. Change a problem on the problem list 
3. Display the active problem list 
4. Display the historical problem list 

 
(a.2) CPOE – Labs 
 

1. Record Lab order via CPOE 
2. Change Lab order via CPOE 
3. Display changed CPOE Lab order 

 
 
(a.3) CPOE – Diagnostic Imaging 
 

1. Record Imaging order via CPOE 
2. Change Imaging order via CPOE 
3. Display changed CPOE Imaging order 

 

(b.2) Clinical Information Reconciliation and Incorporation 

1. Incorporate a CCDA  
2. Conduct reconciliation of the medications, medication allergies, and problems in the CCDA  
3. Generate a new CCDA with reconciled data 
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A summary of the User Tasks prioritization ranking based on the Risk associated with user errors and patient 
safety is shown in Table 3. 
 
 
Table 3: Task Risk Ranking Pre-& Post test 
 

Measure/Task Risk Pre-Reason for Risk Post Risk Observations 
(a.6) Problem List    
Record a problem to the 
problem list 

6 User could find themselves in the 
wrong patient chart 

No error observed during testing.   

Change a problem on the 
problem list 

7 Very Low risk because end-user has 
knowledge and is solely updating 
information. 

No error observed during testing.   

Display the active problem 
list 

7 Very Low risk because end-user has in 
this phase is read only. 

No error observed during testing.   

Display the historical 
problem list 

7 Very Low risk because end-user has in 
this phase is read only. 

No error observed during testing.   

(a.2) CPOE – Labs    
Record Lab order via CPOE 6 User could find themselves in the 

wrong patient chart 
No error observed during testing.   

Change Lab order via CPOE 7 Very Low risk because end-user has 
knowledge and is solely updating 
information. 

No error observed during testing.   

Display changed CPOE Lab 
order 

7 Very Low risk because end-user has in 
this phase is read only. 

No error observed during testing.   

(a.3) CPOE – Diagnostic 
Imaging 

   

Record Lab order via CPOE 6 User could find themselves in the 
wrong patient chart 

No error observed during testing.   

Change Lab order via CPOE 7 Very Low risk because end-user has 
knowledge and is solely updating 
information. 

No error observed during testing.   

Display changed CPOE Lab 
order 

7 Very Low risk because end-user has in 
this phase is read only. 

No error observed during testing.   

(b.2) Clinical Information 
Reconciliation and 
Incorporation 

   

Incorporate a CCDA  5 Information can be duplicated by 
creating a second record or even 
applied to the wrong person due to 
human error 

No error observed during testing.   

Conduct reconciliation of the 
medications, medication 
allergies, and problems in 
the CCDA  

6 Information can be applied to the 
wrong person due to human error 

Most user experience was not 
easy but were able to complete 
the task. This task is normally 
assigned to other staff. 
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Generate a new CCDA with 
reconciled data 

7 Very low risk because the information 
is exporting information as defined by 
the end-user 

1 user experience failure, this is 
this low risk because patient 
could generate information. 

Risk Probability Key    
1 - Very High Risk  Note: Users usage did not demonstrate an increase in potential risk to patients. 

 
2 - High Risk     
3 - Moderate-High Risk    
4 - Moderate Risk     
5 - Moderate-Low Risk    
6 - Low Risk     
7 - Very Low Risk     

 
PROCEDURES 

 
Upon starting the remote connection, GoToMeeting session, the participant was greeted; their identity was 
verified and matched with a name on the participant schedule. Each participant read and agreed to a recording 
consent and signed a non-disclosure agreement and informed consent form (See Appendix 3). The administrator 
from the test team witnessed the participant’s acknowledgement and acceptance. Some sessions were 
recorded for quality purposes and analysis. 
 
The usability testing administrators who conducted the tests were experienced Information Technology and 
Health Information Specialists with 5-15 years of experience with EHRUT, backgrounds in healthcare, health 
information technology and clinical EHR training, implementation and support. 
 
The administrator moderated the session including administering instructions and tasks. The administrator also 
monitored task times, obtained post-task rating data, and took notes on participant comments. They also served 
as the data logger and took notes on task success, path deviations, number and type of errors. 

Participants were instructed to perform the tasks (see specific instructions below): 

• As quickly as possible making as few errors and deviations as possible. 
• Without assistance; administrators could give immaterial guidance and clarification on tasks, but not 

instructions on use. 
• Withholding questions until the end of the test. 

 
For each task, the participants were given a written copy of the task. Task timing began once the administrator 
finished reading the question and indicated to start. The task time was stopped once the participant said, 
“Done,” or otherwise indicated they had successfully completed the task. Scoring is discussed below in the Data 
Scoring section. 
 
Following the session, the administrator gave the participant the post-test questionnaire (e.g., the System 
Usability Scale, see Appendix 5), and thanked them for their participation.  
 
Participants' demographic information, task success rate, time on task, errors, deviations, verbal responses, and 
post-test questionnaire were recorded into a spreadsheet. 
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TEST LOCATION 
 

All participants were tested on the MedInformatix EHR V7.7 system during remote 
conferencing sessions using GoToMeeting. The test participants used their own computer terminals that could 
connect to the Internet with a GoToMeeting session. Participants were located at their place of employment, to 
ensure maximum comfort in their usual work environment. The environment was verified as comfortable for 
users, noise levels were kept to a minimum with the ambient temperature within a normal range. 
 
During a given GoToMeeting session, only the test administrator and participant communicated with one 
another. The GoToMeeting usability test session was conducted by a test administrator from MedInformatix 
Product team working from their office or a small conference room. The test administrator accessed and 
observed the completion of tasks via remote access to the participants terminal.  During a session, only the test 
administrator could see the participant’s screen and hear the participant’s comments, questions, and responses. 
 

 
TEST ENVIRONMENT 

The EHRUT would typically be used in an ambulatory healthcare setting. In this instance, testing of the 
MedInformatix EHR V7.7 system was conducted via remote connection during individual GoToMeeting sessions. 
Each participant was sent a GoToMeeting invitation for their specific testing session.  

For testing, the computer used a Windows 2016 Data Center running OS 64-bit Intel ® Xeon ® 2.4 GHZ. The 
MedInformatix EHR V7.7 application was set up by the vendor according to MedInformatix documentation 
describing the system set-up and preparation. The application itself ran on a client/server platform using a 
sample test database set up specifically for the test on a WAN connection. Participants used their keyboard and 
mouse when interacting with the EHRUT and logged in directly to the application to perform the tasks. The 
application was set to default system preferences. 

Technically, the system performance (i.e., response time) was representative to what actual users would 
experience in a field implementation. Additionally, participants did not change any of the default system 
settings (such as control of font size). 
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TEST FORMS AND TOOLS 
 

During the usability test, various documents and instruments were used, including: 

• Participant Recruiting Screener 

• Recording Consent Form 

• Informed Consent 

• Facilitator’s Guide 

• Tasks 

• Post-test Questionnaire 

• Task Confidence Questionnaire 

• Datalogger Spreadsheet 

Examples of some of these documents can be found in Appendices 1-6 respectively. Participants’ interaction 
with MedInformatix EHR V7.7 was captured and recorded digitally using GoToMeeting software running on the 
test administrator’s workstation. Verbal responses were recorded through GoToMeeting recording software 
(microphone integrated into the participant’s computer or through a telephone connection).  

The participant’s interaction with the EHRUT was captured and recorded digitally with screen capture software 
running on the administrator’s machine.  

 
  



Version 7.7 
 

Page 14 of 38 

F    
 
 
 
 

14 | EHR Usability Test Report of MedInformatix EHR V7.7 
 

PARTICIPANT INSTRUCTIONS 
 

The administrator reads the following instructions aloud to the participant (also see the full 
facilitator’s guide in Appendix [4]. 

Thank you for participating in this study. Our session today will last 60-90 minutes. During that time, you will 
look at MedInformatix V7.7 electronic health record system. 

I will ask you to complete a few tasks using this system and answer some questions. We are interested in how 
easy (or how difficult) this system is to use, what in it would be useful to you, and how we could improve it. You 
will be asked to complete these tasks on your own trying to do them as quickly as possible with the fewest 
possible errors or deviations. Do not do anything more than asked. If you get lost or have difficulty, I will provide 
minimal assistance with anything to do with the system itself. Please save your detailed comments until the end 
of a task or the end of the session when we can discuss freely. I did not have any involvement in its creation, so 
please be honest with your opinions.  

The product you will be using today is currently in development. Some of the screens or functionality may or may 
not be new to you. 

We are recording the audio and screenshots of our session today. All the information that you provide will be 
kept confidential and your name will not be associated with your comments at any time. Should you feel it 
necessary you are able to withdraw at any time during the testing. 

Do you have any questions or concerns? 

Following the procedural instructions, participants were shown the EHR and as their first task, were given time 
(5 minutes) to ask questions and/or make comments. Once this task was complete, the administrator gave the 
following instructions: 

For each task, I will read the description to you and say “Begin.” At that point, please perform the task and say “Done” once 
you believe you have successfully completed the task. I would like to request that you not talk aloud or verbalize while you are 
doing the task.  I will ask you your impressions about the task once you are done. 

Participants were then given 13 tasks to complete. Tasks are listed in the facilitator’s guide in Appendix [4]. 
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USABILITY METRICS 
According to the NIST Guide to the Processes Approach for Improving the Usability of Electronic Health Records, 
EHRs should support a process that provides a high level of usability for all users. The goal is for users to interact 
with the system effectively, efficiently, and with an acceptable level of satisfaction. To this end, metrics for 
effectiveness, efficiency and user satisfaction were captured during the usability testing. 

The goals of the test were to assess: 

 

1. Effectiveness of MedInformatix EHR V7.7 by measuring participant success rates and errors 

2. Efficiency of MedInformatix EHR V7.7 by measuring the average task time and path deviations 

3. Satisfaction with MedInformatix EHR V7.7 by measuring ease of use ratings 
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DATA SCORING 

 
The following table (Table 4) details how tasks were scored, errors evaluated, and the time data analyzed. 

  Table 4. Details of how observed data were scored. 

Measures Rationale and Scoring 
Effectiveness: 

Task Success 
Task success was determined by assigning numeric weights for various levels of task success, as 
follows: 
• Easy -Pass (without assistance) = 5  
• Medium -Partial success (minimal assistance) = 3 
• Hard – Partial Success took longer than expected) = 1 
• Fail – Failure (gave up or failed) = 0 

 

The results are provided as a percentage. 

 Effectiveness: 

Task Failures 

If the participant abandoned the task, did not reach the correct answer or performed it incorrectly, 
or reached the end of the allotted time before successful completion, the task was counted as a 
“Fail.” No task times were taken for errors. 

Note: Not all deviations would be counted as errors 

Efficiency: 

Task Deviations 

The participant’s navigation path (i.e., steps) through the application was recorded. Deviations 
occur if the participant, for example, went to a wrong screen, clicked on an incorrect menu item, 
followed an incorrect link, or interacted incorrectly with an on-screen control. This path was 
compared to the optimal path. The number of steps in the observed path is divided by the number 
of optimal steps to provide a ratio of path deviation.  
 

Efficiency: 
Task Time 

Each task was timed from when the administrator said “Begin” until the participant said, “Done.” If 
he or she failed to say “Done,” the time was stopped when the participant stopped performing the 
task. Only task times for tasks that were successfully completed were included in the average task 
time analysis. Average time per task was calculated for each task. Variance measures (standard 
deviation and standard error) were also calculated. 

Satisfaction: 
 
 
Task Rating 
 
 
 
 
 
 
 
System Satisfaction 

Participant’s subjective impression of the ease of use of the application was measured by 
administering both a simple post-task question as well as a post-session questionnaire. After each 
task, the participant was asked to rate “How confident they are that they were able to use the 
product being tested to complete the given task.” on a scale of 1 
(Very Difficult) to 7 (Very Easy). These data are averaged across participants. 

Common convention is that average ratings for systems judged easy to use should be 4 or above. 

To measure participants’ confidence in and likeability of MedInformatix EHR V7.7 overall, the 
testing team administered the System Usability Scale (SUS) post-test questionnaire.  Questions 
included, “I think I would like to use this system frequently,” “I thought the system was easy to 
use,” and “I would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire in Appendix 5 – System 
Usability Scale Questionnaire.  
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RESULTS 
 
DATA ANALYSIS AND REPORTING 

The results of the usability test were calculated and analyzed according to the methods specified in the Usability 

Metrics section above. The usability testing results for MedInformatix EHR V7.7 are detailed in the sections 

below (see Table 5). The results should be seen considering the objectives and goals outlined in Study Design 

section. The data yielded actionable results that, if corrected, yield material, positive impact on user 

performance.   

Table 5: Testing Results – Summary of overall task performance 

Measure 
 

Task 

 
 

N 

Task 
Success 
% 

Path 
Deviation # of 
steps 

Task Time - Secs Errors Task Rating Avg 
5=Easy 

# Mean SD Obs./Opt. SD Mean SD Opt. Mean SD Mean 

  

SD 

 

 

1. A.6 Record a problem to the problem 
list 

10 100 0 5/5 0 13.9 8.63 6 0 0 5.0 0 

2. A.6 Change a problem on the problem 
list 

10 96 0.6 6/5 0.3 28.0 10.72 22 0 0 4.9 0.3 

3. A.6 Display the active problem list 10 100 0 3/3 0 14.5 13.33 10 0 0 5.0 0 

4. A.6 Display the historical problem list 10 100 0 1/1 0 16.9 28.84 4 0 0 5.0 0 

5. A.2 Record Lab order via CPOE 10 96 0.6 5/4 0.3 10.9 6.33 8 0 0 4.9 0.3 

6. A.2 Change Lab order via CPOE 10 100 0 6/6 0 15.2 4.85 14 0 0 5.0 0 

7. A.2 Display changed CPOE Lab order 10 96 0.6 3/2 0.3 8.6 4.25 6 0 0 4.8 0.4 

8. A.3 Record Lab order via CPOE 10 96 0.6 5/4 0.3 11.0 3.74 9 0 0 4.9 0.3 

9. A.3 Change Lab order via CPOE 10 100 0 6/6 0 12.4 3.58 11 0 0 5.0 0 

10. A.3 Display changed CPOE Lab order 10 100 0 2/2 0 5.7 6.21 3 0 0 5.0 0 

11. B.2 Incorporate a CCDA  10 96 0.6 6/5 0.3 35.5 37.77 13 0 0 4.7 0.46 

12. B.2 Conduct reconciliation of the 
medications, allergies, and problems in 
the CCDA with the information currently 
in the patient’s record 

10 68 1.5 18/10 0.4 69.4 34.72 56 0 0 3.7 0.9 

13. B.2 Generate a new CCDA with 
reconciled data 10 74 1.02 15/10 0.9 51.2 20.04 50 0.01 0.3 4.4 0.65 
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The results from the System Usability Scale (SUS) scored the subjective satisfaction with the system based on 
performance with these tasks to be: 87 %.  Broadly interpreted, scores under 60 represent systems with poor 
usability; scores over 80 would be considered above average. Table 5 indicates participant performance in the 
MedInformatix EHR V 7.7 usability test was quite satisfactory. The overall average task completion rate was 
94%.  
The following charts show details of task performance, task completion, users’ self-rated confidence level in 
using the EHRUT, time spent per task and finally the system satisfaction rating. 
 

Chart 1. Task Performance – Shows the % distribution of scored criteria per task 
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Chart 1: Task Performance
TASK 4 5 6 7 8 9 10 11 12 13 14 15 16
1-word A6-1 A6-2 A6-3 A6-4 A2-1 A2-2 A2-3 A3-1 A3-2 A3-3 B2-1 B2-2 B2-3
Easy 10 9 10 10 9 10 9 9 10 10 9 2 5
Medium 1 1 1 1 1 8 4
Hard
Fail 1



Version 7.7 
 

Page 19 of 38 

F    
 
 
 
 

19 | EHR Usability Test Report of MedInformatix EHR V7.7 
 

 

 

Chart 2. Task Completion – Shows the basic proportion of Successful Tasks / Total Tasks Performed 

 

Data Chart 3: Task Completion & User Confidence Ratings (Non-adjusted) 

 

Data Chart 3. Task Completion and User Confidence 

TASK 4 5 6 7 8 9 10 11 12 13 14 15 16 

1-word A6-1 A6-2 A6-3 A6-4 A2-1 A2-2 A2-3 A3-1 A3-2 A3-3 B2-1 B2-2 B2-3 

Successful 1 1 1 1 1 1 1 1 1 1 1 1 0.9 

Conf Rating 1 0.97 1 1 0.99 1 0.97 0.99 1 1 0.96 0.81 0.92 
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Chart 4. Time Spent/Task (Mean w/ Max & Min) 

 

Data Chart 4: Time per Task 

TASK 4 5 6 7 8 9 10 11 12 13 14 15 16 

1-word A6-1 A6-2 A6-3 A6-4 A2-1 A2-2 A2-3 A3-1 A3-2 A3-3 B2-1 B2-2 B2-3 

Mean 14 28 15 17 11 15 9 11 12 6 36 69 51 

Max-Mean 19 21 40 83 15 9 8 8 6 18 106 49 34 

Mean-Min 10 16 9 14 7 9 6 5 6 4 29 49 36 

 

 

 

 

 

 

A6-1 A6-2 A6-3 A6-4 A2-1 A2-2 A2-3 A3-1 A3-2 A3-3 B2-1 B2-2 B2-3
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Chart 5. Satisfaction (System Usability Scale) 

 

SUS Histogram 

    SUS Histogram Tally (read only) 
  Item# 1 2 3 4 5 N   
  1 0 0 0 4 6 10   
  2 6 4 0 0 0 10   
  3 0 0 0 4 6 10   
  4 5 3 2 0 0 10   
  5 0 0 1 5 4 10   
  6 6 2 2 0 0 10   
  7 0 0 0 5 5 10   
  8 6 4 0 0 0 10   
  9 0 0 0 3 7 10   
  10 4 4 2 0 0 10   

 

  

87.0 % SUS Score

System Usability Scale Histogram

1 2 3 4 5
I think I would like to use this software product frequently. |||| ||||

||

I found the product unnecessarily complex. ||||
||

||||

I thought the product was easy to use. |||| ||||
||

I think I would need Tech Support to be able to use this product. ||||
|

||| ||

I found the various functions in this product were well integrated. | ||||
|

||||

I thought there was too much inconsistency in this product. ||||
||

|| ||

I imagine that most people would learn to use this product very quickly. ||||
|

||||
|

I found the product very cumbersome to use. ||||
||

||||

I felt very confident using this product. ||| ||||
|||

I need to learn a lot about this product before I could effectively use it. |||| |||| ||

Strongly
Agree

Strongly
Disagree
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DISCUSSION OF THE FINDINGS 
 
In general, the participants performed very well and were satisfied with MedInformatix EHR V7.7 system. Some 
were very impressed with the new features and the improvements from previous version and stated that they 
couldn’t wait to move to that version. There were a few participants that had trouble with some parts of a few 
tasks (took longer time to complete) but in general they were able to successfully complete all the tasks with 
little or no difficulty. Participants performed all tasks on their own with no assistance. They were given a demo 
of new features at the beginning of the test; no external documentation was provided. The average 
performance rate and overall participant satisfaction rates were very high. The MedInformatix EHR V7.7 
system appears to be a highly usable EHR. Below are the individual criteria test findings. 
 
Analysis of the Use, Tested Performance, and Error Rates 

Based on the analysis of the data and the observed performance of the participants during testing we did not 
identify any risk prone errors – with a potential likelihood of occurrence and adverse consequences to patients. 
Please see Table 3 For the perceived risk analysis and the post risk results.  We do note that one user was 
consistently slow to complete task which dramatically increase observable mean time, they did not fail any task 
but perform tasks slowly and without error. 

 
CPOE Laboratory 170.315.a.2 

For the CPOE Laboratory criteria our participants engaged in the following tasks: 

 

1. Record Lab order via CPOE 

2. Change Lab order via CPOE 

3. Display changed CPOE Lab order 

 

EFFECTIVENESS 
Based on the success, failure and path deviation data, the design of the CPOE functionality appears to be 

effectively designed and configured. Users were able to easily place clinical orders. The design of the screens 

required for Laboratory appear to be effective. The participants were able to successfully record, change and 

display the changed lab orders entries using CPOE, resulting into a success average score of 97.3%. 

 

EFFICIENCY  
Based on the observations of the task time and deviation data, users were able to order laboratory efficiently 

and to order other tests quickly.    Most of the participants outdid the optimal time while performing the tasks, 

and completed the tasks within the optimal number steps, as suggested by the number of steps taken by expert 

users. We observed one minor deviation due to participant not following instructions correctly. 
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SATISFACTION  
Based on the task ratings and SUS results data, users appear to be satisfied with the design and found the 

interaction to be uncomplicated and easy to complete. The participants were familiar with these tasks and gave 

an average satisfaction rate of 4.9 out of 5 points. 

 

MAJOR FINDINGS  

• The Laboratory-ordering task requires searching a list and thought must be given as to how the list is 

composed for the client, but overall interaction was effective and efficient.   

 

Based on the success, failure and path deviation data, the design of the CPOE laboratory functionality appears 

to be effectively designed and configured. Users could easily add and modify historical and new lab orders. 

Users were able to easily place lab orders. Overall all our participants found these tasks to be easy, effective and 

had a high confidence rating. Noticed some slight variation in times due to some participants taking more time 

to update SNOMED codes and find correct one. 

 

AREAS FOR IMPROVEMENT  

• Look for ways to guide the user through the required steps in the Laboratory-ordering process, i.e., after the 

order is placed, prompting the user to complete any supporting tasks, outside of any ONC required workflow. 
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CPOE Diagnostic Imaging 170.315.a.3 
 

For the CPOE Diagnostic Imaging criteria our participants engaged in the following tasks: 

1. Record Imaging order via CPOE 

2. Change Imaging order via CPOE 

3. Display changed CPOE Imaging order 

 
EFFECTIVENESS  

Based on the success, failure and path deviation data, the design of the CPOE Diagnostic Imaging functionality 

appears to be effectively designed and configured. Users were able to easily place diagnostic imaging orders. 

The design of the screens required for diagnostic imaging appear to be effective, apart from providing clear 

status of diagnostic imaging – whether they are processed. The average success rate for CPOE Diagnostic 

Imaging was 98.7%. 

 

EFFICIENCY  

Based on the observations of the task time and deviation data, users were able to order diagnostic imaging 

orders efficiently and to order other tests quickly.   Most of the participants outdid the optimal time while 

performing the tasks, and completed the tasks within the optimal number steps, as suggested by the number of 

steps taken by expert users. We observed one participant going over the optimal time and having some 

deviations because they opted to perform additional steps not required by the task. 

 

SATISFACTION  
Based on the task ratings and SUS results data, users appear to be satisfied with the design and found the 

interaction to be uncomplicated and easy to complete. The participants were familiar with these tasks and gave 

an average satisfaction rate of 4.96 out of 5 points. 

 

MAJOR FINDINGS  
• The diagnostic imaging -ordering task requires searching a list and thought must be given as to how the 

list is composed for the client, but overall interaction was effective and efficient.   
• Some prefer an A-Z list while others preferred based on location. 
• Participants liked the format of the C-CDA. 
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Based on the success, failure and path deviation data, the design of the CPOE Diagnostic Imaging functionality 

appears to be effectively designed and configured. Users could easily add and modify historical and new images. 

Users were able to easily place diagnostic images orders. Overall all our participants found these tasks to be 

easy, effective and had a high confidence rating.  

 

AREAS FOR IMPROVEMENT 

 • Look for ways to guide the user through the required steps in the diagnostic imaging ordering process, i.e., 

after the order is placed, prompting the user to complete any supporting tasks. 

 

 
CPOE Problem List 170.315.a.6 

For the Problem List criteria our participants engaged in the following tasks: 

1. Record a problem to the problem list 

2. Change a problem on the problem list 

3. Display the active problem list 

4. Display the historical problem list 

 

EFFECTIVENESS  
The success score for recording a problem and displaying the problems was 100%. However, some of the 

participants faced slight difficulty while changing the problem. The participants were able to successfully record, 

change and display a problem to the problem list, resulting into a success average score of 99%. 

Based on the success, failure and path deviation data, the design of the problem list functionality appears to be 

effectively designed and configured. Users were able to easily place problems. The design of the screens 

requires users to enter both the SNOMED value along with the ICD10. 

 

EFFICIENCY  

Based on the observations of the task time and deviation data, users were able to place the Problem efficiently 

and record the item(s) quickly.   Most of the participants were under/same as the optimal time while performing 

the tasks, and completed the tasks within the optimal number steps, as suggested by the number of steps taken 

by expert users. We observed one participant going over the optimal time and having some deviations because 

of lack of familiarity with the screen as well as was interpreting 
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SATISFACTION  

Based on the task ratings and SUS results data, users appear to be satisfied with the design and found the 

interaction to be uncomplicated and easy to complete. The participants were familiar with these tasks and gave 

an average satisfaction rate of 4.98 out of 5 points. 

 

MAJOR FINDINGS  

• User tended to be very familiar with ICD10 but SNOMED took some time as they search for an appropriate 

match from the drop-down list. 

 
AREAS FOR IMPROVEMENT  

• Users express the need to begin with SNOMED and then go to ICD10.  (This improvement can be found with 

the IMO Search UCD phase 3 report) 
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CPOE Clinical Information Reconciliation and Incorporation 170.315.b.2 
For the Clinical Information Reconciliation criteria our participants engaged in the following tasks: 

1. Incorporate a CCDA  

2. Conduct reconciliation of the medications, medication allergies, and problems in the CCDA with 

the information currently in the patient’s record 

3. Generate a new CCDA with reconciled data 

 
EFFICIENCY  

Based on the observations of the task time and deviation data, users were able to append clinical information 

into the patient’s chart with trivial nuances.   Some of the participants were under/same as the optimal time 

while performing the tasks, and completed the tasks within the optimal number steps, as suggested by the 

number of steps taken by expert users. We observed a few participants going over the optimal time and having 

some deviations because of lack of familiarity with the screen as well as interpreting the data being imported. 

Users selected don’t perform this task, additional training is normally done in 1 hour versus 20 minutes. 

  

SATISFACTION  
Based on the task ratings and SUS results data, users appear to be satisfied with the design and found the 

interaction to be uncomplicated and easy to complete. The participants rated these tasks and gave an average 

satisfaction rate of 4.3 out of 5 points. Additional training might increase satisfaction. 

  

MAJOR FINDINGS  

• Many of the participants do not participate with this portion of the software; as such, took longer to execute 

task although completed task with deviations or errors, confidence was still high.  Many reported that with 

additional training they could complete the task with better results. 

  

AREAS FOR IMPROVEMENT  

• Provide alert when no data is merged due to the accidental closure of the screen. 
• Users deviations observed lead us to seek improvement at a later time 
• When user may be leaving the reconciliation without importation provide alert that such action is about 

to happen. 
• Improve the process of accepting changes or updating information. 
• Addition of larger buttons to make the action stand out. 
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APPENDICES 
 

Appendix 1: SAMPLE PARTICIPANT RECRUITING SCREENER 
 

At the beginning of each usability test session, the test administrator asked participants the questions on the 

recruiting screener and recorded the responses. 

Participant Questionnaire 
 

1. Date of Testing ____________________ 

2. Participant ID____________________________________________________________ 

3. Description of Intended Users _______________________________________________ 

4. Participant Gender________________________________________________________ 

5. Participant Age___________________________________________________________ 

6. Participant Education______________________________________________________ 

7. Participant Occupation/Role_________________________________________________ 

8. Participant Professional Experience___________________________________________ 

9. Participant Computer Experience_____________________________________________ 

10. Participant Product Experience ______________________________________________ 

11. Does the Participant have any Assistive Technology Needs________________________ 
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Appendix 2: PARTICIPANT DEMOGRAPHICSGender  
Female 10 
Male 0 
  
Age Range  
30 to 39 5 
40 to 49 2 
50 to 59 2 
60-69 1 
  
Education  
Some college credit, no degree 0 
Trade technical vocational training 0 
Associate degree 5 
Bachelor’s degree 2 
Master’s degree 2 
Doctorate degree 1 
  
Years of Experience with EHRUT  
None 0 
Up to 3 years 1 
3 - 5 years 1 
5 – 10 years 3 
10 – 15 years 2 
15 – 20 years 3 
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Appendix: 3: NON-DISCLOSURE AGREEMENT AND INFORMED CONSENT 
FORM 

NON-DISCLOSURE AGREEMENT AND INFORMED CONSENT FORM  
  

Non-Disclosure Agreement THIS AGREEMENT is entered as of _ _, 2018, between (“the 
Participant”) and the testing organization MedInformatix, Inc. located at Address.  
  
The Participant acknowledges his or her voluntary participation in today’s usability 
study may bring the Participant into possession of Confidential Information. The term 
"Confidential Information" means all technical and commercial information of a 
proprietary or confidential nature which is disclosed by MedInformatix, or otherwise 
acquired by the Participant, during today’s study.  
  
By way of illustration, but not limitation, Confidential Information includes trade 
secrets, processes, formulae, data, know-how, products, designs, drawings, computer 
aided design files and other computer files, computer software, ideas, improvements, 
inventions, training methods and materials, marketing techniques, plans, strategies, 
budgets, financial information, or forecasts.  
  
Any information the Participant acquires relating to this product during this study is 
confidential and proprietary to MedInformatix and is being disclosed solely for the 
purposes of the Participant’s participation in today’s usability study. By signing this 
form, the Participant acknowledges that s/he will not disclose this confidential 
information obtained today to anyone else or any other organizations.  
  
Participant’s printed name:      
  
 
 
Signature:    Date:     
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Appendix 4: EXAMPLE FACILITATOR’S GUIDE 

FACILITATOR’S GUIDE 
Before Recording: 

Thank you for agreeing to participate in this usability study. Our session will last 60-90 minutes. Today you will 

be helping us evaluate workflows pertaining to the 2015 ONC's EHR Vendor Certification requirements. In a 

moment I will be asking you to complete these workflows using MedInformatix EHR V 7.7. I'll be taking notes.  

You have been provided a Participant Guide. This information is available for reference only. I will talk you 

through each step of the process and then ask all the questions. After I have asked the question, you may refer 

to the Participant Guide for more detail. You will be asked to complete these tasks on your own trying to do 

them as quickly as possible with the fewest possible errors or deviations. Do not do anything more than asked. 

Also, I want you to hold your questions, until the end since the tasks are being timed. I would ask to please be 

honest with your opinions. Do you have any questions regarding the documentation provided? 

<Facilitator: If you determine that the Participants questions should be part of the recorded session please have 

them ask it again during the recording. Answer questions and start appropriate demos (PHR etc.).> Before we 

get started I would like to record this session to help me later with my report. Therefore, to help with this data 

collection, we are seeking your verbal consent to record the session <Show consent form> 

Begin Recording: 

<Ask them to please read out loud "I understand that my usability test session will be recorded. I grant 

MedInformatix, Inc. permission to use this recording for internal use only, for improving the products being 

tested." from the consent form.> 

What you will be looking at today is MedInformatix EHR V7.7 populated with a mock patient's information. I will 

ask you to complete a few tasks using this system and answer some questions. please keep in mind that the 

data may not be clinically accurate, and we understand that it may not be applicable to your specialty. We are 

interested in how easy (or how difficult) this system is to use, what in it would be useful to you, and how we 

could improve it.  

I will ask you to start when I say, "BEGIN NOW", and please tell me when you think you've completed the task by 

saying “DONE”. If you feel lost or have difficulty completing the scenario, please continue to try as best as you 

can. If you are unable to complete the task, we will stop the task and move you on to the next task. At the end 

of the session, I will ask you additional questions and there will be a survey. Please understand, we are 

evaluating the ease of use on the software and not your performance on this system.  

 Do you have any questions or concerns? 
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Prior to beginning test – administrator must: 

 

1. Use the datalogger spreadsheet to record the participant’s experience. 
a. Find the participants identification number and fill out the chart information 
b. Time each task from when the administrator said “Begin” until the participant said, “Done.” Include only 

task times for tasks that were successfully completed in the average task time analysis 
c. Record how many times a task was completed successfully and how many times it was attempted. 
d. Record the path that a participant used to complete the task (count the clicks). Record the difference 

and ratio of the observed path to the optimal path 
e. Record the difference and ratio of the observed time and the optimal time 
f. Count the total number of failed attempts to complete the task (errors), and divide by the total number 

of times that task was attempted 
g. Record task score – Easy – Medium – Hard - Fail 

<BEGIN TEST> 

 
UCD Phase 2 Tasks 
 
Criteria – Problem List 170.315.a.6 
 

Task 1 – Access the Problem List 

 Facilitator instruct the participant to start the first task, following the ‘A.6 Participant Instructions’ document:  
- “In the system, select Jane Doe and enter in the Problem list provided below treat as historical data” 
- Confirm this is an Active Problem 
- Headache R51; Chronic headache disorder SNOMED code: 431237007 
- Optimal Path: Patient List > Enter patient name > Click Chart Icon > Click DX button > Stop test (Observer 

should hear "I'm done") 
- Optimal Time:  6s 
- Record the following as applicable: Score, Time, Observations, Conf. 

 

Task 2 – Record a new Problem  

Facilitator instruct the participant to start the second task, following the ‘A.6 Participant Instructions’ document: 
- “In the system, start from the last window” 
- Record the following new problem: 
- Portal hypertension K76.6; Portal hypertension (disorder); SNOMED code: 44054006 
- Optimal Path: Add Dx>Search text>Select SNOMED>Add>Stop test 
- Optimal Time:  22s 
- Record the following as applicable: Score, Time, Observations, Conf. 

 

Task 3 – Change an existing Problem  

Facilitator instruct the participant to start the third task, following the ‘A.6 Participant Instructions’ document: 
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- “In the system, start from the last window” 
- Update problem list: 
- Chronic headache disorder is improving 
- Optimal Path: Change Status> double click improving> stop test 
- Optimal Time:  10s 
- Record the following as applicable: Score, Time, Observations, Conf. 

 

Task 4 – View the Full List of Problem(s) 

Facilitator instruct the participant to start the fourth task, following the ‘A.6 Participant Instructions’ document: 
- “In the system, start from the last window” 
- Show the resolved item when accessing the full list.  Confirm  
- Acne, unspecified L70.9; Juvenile acne SNOMED Code: 238743000 is present 
- Optimal Path: Show resolved Items> stop test 
- Optimal Time:  4s 
- Record the following as applicable: Score, Time, Observations, Conf. 

 

Criteria – CPOE Laboratory 170.315.a.2 
 

Task 1 – Record Laboratory Orders 

 Facilitator instruct the participant to start the first task, following the ‘A.2 Participant Instructions’ document:  
- “In the system we will start in the HEAP tree.” 
- Order a CBC 
- Optimal Path: Plan > Laboratory Order > Select CBC > Order button>Stop test 
- Optimal Time:  8s 
- Record the following as applicable: Score, Time, Observations, Conf. 

 

Task 2 – Change Laboratory Orders 

Facilitator instruct the participant to start the second task, following the ‘A.2 Participant Instructions’ document:  
- “In the system, start where you left off.” 
- Replace CBC with lipid panel 
- Optimal Path: Order> highlight> delete> OK> replace order> Order> Stop test 
- Optimal Time:  14s 
- Record the following as applicable: Score, Time, Observations, Conf. 

 

Task 3 – Access Laboratory Orders 

Facilitator instruct the participant to start the third task, following the ‘A.2 Participant Instructions’ document:  
- “In the system, start where you left off.” 
- Visit order screen and show the changes made 
- Optimal Path: Order>Show deleted/discontinued items> Stop test 
- Optimal Time:  6s 
- Record the following as applicable: Score, Time, Observations, Conf. 
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Criteria – CPOE Diagnostic Imaging 170.315.a.3 
 

Task 1 – Record Diagnostic Imaging Orders 

 Facilitator instruct the participant to start the first task, following the ‘A.3 Participant Instructions’ document:  
- “In the system we will start in the HEAP tree.” 
- Order a nuclear Bone Scan 3 phase 
- Optimal Path: Plan > Diagnostic Imaging > Select scan 3 > Order button>Stop test 
- Optimal Time:  9s 
- Record the following as applicable: Score, Time, Observations, Conf. 

 

Task 2 – Change Diagnostic Imaging Orders 

Facilitator instruct the participant to start the second task, following the ‘A.3 Participant Instructions’ document:  
- “In the system, start where you left off.” 
- Replace Nuclear Bone Scan 3 phase with Nuclear Bone Scan Whole Body  
- Optimal Path: Order> highlight> delete> OK> replace order> Order> Stop test 
- Optimal Time:  11s 
- Record the following as applicable: Score, Time, Observations, Conf. 

 

Task 3 – Access Diagnostic Imaging Orders 

Facilitator instruct the participant to start the third task, following the ‘A.3 Participant Instructions’ document:  
- “In the system, start where you left off.” 
- Visit order screen and show the changes made 
- Optimal Path: Order> Show deleted/discontinued items> Stop test 
- Optimal Time:  3s 
- Record the following as applicable: Score, Time, Observations, Conf. 
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Criteria – Clinical Information Reconciliation 170.315.b.2 
 

Task 1 – Incorporate a CCDA 
Facilitator instruct the participant to start the first task, following the ‘B.2 Participant Instructions’ document.   
Facilitator the purpose of this test is to download and import the CCDA. 

- The user should log into the PHR 
o Username: SUP, Password: A2 

- Open Continuity of Care Document 
o Load File (opens Windows Explorer) 
o Open CCD folder (located beneath downloads) 
o select Jane Doe 
o Click View CCDA 
o User reviews CCDA and ensures it’s readable 
o Close CCDA 

- User stays on CCDA Import Screen for Second Task 
- Participants instructions: 
- In the Patient Health Record PHR download and view CCDA using the following file: Jane Doe 
- The file above can be found in C:\CCDA use Windows Explorer to find the file 
- Optimal Path: Login PHR > Download CCDA> Select file > View CCDA > Close CCDA>Stop test 
- Optimal Time:  13 s 
- Record the following as applicable: Score, Time, Observations, Conf. 

 

Task 2 – Conduct reconciliation of the medications, medication allergies, and problems in the CCDA with the 

information currently in the patient’s record 
Facilitator instruct the participant to start the second task, following the ‘B.2 Participant Instructions’ document. 
Facilitator Instructions - The goal is to download and reconcile medications, alerts and diagnosis for correct 
patient. 

- Load File:  User selects file for the appropriate Name: Jane Doe (automatically populates account, if not 
follow steps B and C) 

- B. Click Search 
- C. Click Use Selected 

- CCDA Import Screen opens: 
-  Import (A) Medications, (B) Allergies and (C) Diagnosis 

- Click close the user has completed the first CCDA download and import   
- Participants instructions: 
- In the PHR download, import and reconcile clinical information corresponding to the appropriate Name: 

JANE, DOE 
- Select CDA form for the corresponding patient 
- CDA Import Begins 
- Items to import (2 of each): 1. External Source Medications 2. External Source Allergies 3. 

External Source Diagnosis  
- *Update Diagnosis if applicable * 
- *Accept changes for each corresponding tab* 
- Review and validate accuracy of final data set for each tab, then close 
- Optimal Path: Load File> Import clinical information> Import Medication, Allergies, and Diagnosis> 
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reconcile clinical information times 3> review data> validate accuracy for each tab> close tabs> Stop test 
- Optimal Time:  56 s 
- Record the following as applicable: Score, Time, Observations, Conf. 

 

Task 3 – Generate a new CCDA with reconciled data   
Facilitator instruct the participant to start the third task, following the ‘B.2 Participant Instructions’ document. 
Facilitator Instructions –  

- Add Patients 
- Search for the appropriate Jane Doe 
- Add Selected – Highlight the desired patient and click Add Selection Button (When selection 

appears in the main screen close out the Search for Patients) 
- Select patient and click Continuity of Care Document: 

-  Select CCDA Type to Export -> Next 
- CCDA Export Wizard 

- Template Name: CCD -> Next 
- Export Options -> Use Direct Address: Jeffeory Blackbean -> Unencrypted File -> 

FINISH 
- Participants instructions: 

- In the PHR export a Continuity of Care Document (CCD) using a CCDA template. 
- Export CCDA for the appropriate JANE, DOE 
- Send CCDA to patients Referring Physician using Direct Address;  
- Physician: Jeffeory Blackbeard 

- Optimal Path: Search> Select Patient> Export CCD> 4 prompts> Send CCD> Direct mail> enter Secure 
Email Path> Stop test 

- Optimal Time:  50 s 
- Record the following as applicable: Score, Time, Observations, Conf. 
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Appendix 5: SYSTEM USABILITY SCALE QUESTIONNAIRE

 

 
Participant ID#:______ 
 
These questions will be asked at the end of the testing read and familiarize yourself with them  
 
 
 
                                                               Difficult                                                                                                                Easy  

Overall this task was 
 

                                                            1                 2                3                 4                 5                6                 7                                                          
 
 

 
 
 
 

1. I think that I would like to use 
this system frequently. 

 
2. I found the system unnecessarily 

complex. 
 

3. I thought the system was easy 
to use. 

 
 

4. I think that I would need the 
support of a technical person to 
be able to use this system.  

 
5. I found the various functions 

in this system were well 
integrated.  

 
6. I thought there was too much 

inconsistency in this system.  
 
 

7. I would imagine that most people 
would learn to use this system 
very quickly. 

 
8. I found the system very 

cumbersome to use. 
 
 

9. I felt very confident using the 
system.  

 
10. I needed to learn a lot of 

things before I could get going 
with this system.  

 

Strongly Strongly 
disagree agree 
 
 
 

1 2 3 4 5 
 
 
 

1 2 3 4 5 
 
 
 

1 2 3 4 5 
 
 
 

1 2 3 4 5 
 
 
 
 

1 2 3 4 5 
 
 
 
 
 
1 2 3 4 5 
 
 

 
 

1 2 3 4 5 
 
 

 
1 2 3 4 5 
 
 

 
 
1 2 3 4 5 
 
 

 
 
1 2 3 4 5
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Appendix 6:  RECORDING CONSENT FORM 
 

Recording Consent Form 
 

Thank you for participating in our Usability Client Design Testing. 
We will be recording your session to allow MedInformatix, Inc. staff 
members who are unable to be present today to observe your session and 
benefit from your comments. 
 
Please read the statement below and verbally indicate you accept and 
consent. 
 
 
I understand that my usability test session will be recorded. 
I grant MedInformatix, Inc. permission to use this recording for internal use 
only, for improving the products being tested. 
 
Signature               __________________________________________ 
 
Print Name            __________________________________________ 
 
Date Signed           

__________________________________________ 
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EXECUTIVE SUMMARY 
 
A usability test of MedInformatix EHR V7.7, an ambulatory electronic health record software from 
MedInformatix Inc., was conducted on October 16 through October 23, 2018 in the Los Angeles, CA office by 
MedInformatix product group over remote tele-conferencing sessions using GoToMeeting.  
The purpose of this summative study was to test and validate the usability of the current user interface and 
provide evidence of usability of MedInformatix Complete EHR V7.7 in the EHR Under Test (EHRUT). 
 
During the usability test, ten (10) healthcare providers and/or other intended users matching the target 
demographic criteria served as participants and used the EHRUT in simulated, but representative tasks. 
This study collected performance data on 18 tasks typically conducted on an EHR. The tasks created are 
associated to four (4) of the twelve (12) certification criteria identified in 45 CFR Part 170 Subpart C of the 
Health Information Technology: 2015 Edition Health Information Technology (Health IT) Certification Criteria: 
 
  
 170.315(a)(6) Problem List 
 170.315(a)(9) Clinical Decision Support 
 170.315(a)(14)  Implantable device List 
 170.315(b)(3) Electronic Prescribing 
 
 
During the 90 minutes, one-on-one usability test, each participant was greeted by the administrator and asked 
to review and sign an informed consent/release form (included in Appendix 3); they were instructed that they 
could withdraw at any time. All participants were current users of MedInformatix EHR, so they had prior 
experience with some version of the EHR. The administrator introduced the test and instructed participants to 
complete a series of tasks (given one at a time) using the EHRUT. During the testing, the administrator timed the 
test and, along with the data logger(s) recorded user performance data on paper and electronically. The 
administrator did not give the participant assistance in how to complete the task. 
 
Participant screens and audio were recorded for subsequent analysis. The following types of data were collected 
for each participant: 
 

• Number of tasks successfully completed within the allotted time without assistance 
• Time to complete the tasks 
• Number and types of errors 
• Path deviations 
• Participant’s verbalizations 
• System Usability Scale (SUS) 

 
 
 
All participant data was de-identified – no correspondence could be made from the identity of the participant to 
the data collected.  
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Following the conclusion of the testing, participants were asked to complete a post-test questionnaire but were 
not compensated.  
The UCD process used in the design and development of the above five 2015 Edition Certification criteria was 
based on NISTIR 7741. Various recommended metrics, in accordance with the examples set forth in the NIST 
Guide to the Processes Approach for Improving the Usability of Electronic Health Records, were used to 
evaluate the usability of the EHRUT.  
 
The results from the System Usability Scale (SUS) scored the subjective satisfaction with the system based on 
performance with these tasks to be: 91.0 %. Results of the study indicated that the MedInformatix EHR system 
was quite satisfactory with regards to effectiveness and efficiency. The average Confidence/Ease ratings was 
4.87 out of 5 when asked “How confident/easy was it to use the product being tested to complete the given 
task: on a scale of 1 (Very Difficult) to 5 (Very Easy).” The participants were very satisfied with the system. 
Results are detailed in the Results section of this report, which includes a subsection for each of the four ONC 
CEHRT 2015 Edition criteria.  
 
In addition, to the performance data, the following qualitative observations were made: 
 
MAJOR FINDINGS 

• Three of the four tests included new workflows which users completed successfully without errors. 
• Some users recognized that usage for the office would be limited and appreciated the overall design to 

collect data as defined by the regulations. 
• Users who did not routinely perform a task as part of their every day job function could navigate and 

perform each task easily. 
• Areas with new functionality were introduced to users prior to the task and no major problems were 

observed. 
• Based on feedback, users appear satisfied with the design, and found the interaction uncomplicated and 

easy to complete. 
• Users were highly effective and efficient in completing the tasks 

 
 
AREAS FOR IMPROVEMENT 

• No major areas of improvement were noted. 
• Move Persivia report to avoid an extra click – This change is cosmetic only and can be performed on-site 
• In one screen users clicked on the row instead of the row selector.  User express wanting the ability to 

have the whole row as a selector instead of a limited area. 
• Consider adding a message to confirm the cancellation was completed. 
• Consider button placement for ease of use. 
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INTRODUCTION 
 
The EHRUT tested for this study was MedInformatix EHR - V7.7.  
Designed to present medical information to healthcare providers in radiology and ambulatory settings, the 
EHRUT consists of Practice Management/Scheduling, Billing, and EHR functionality.  The usability testing 
attempted to represent realistic exercises and conditions. 
 
The purpose of this study was to test and validate the usability of the MedInformatix EHR V7.7 user interface 
and provide evidence of usability in the EHR Under Test (EHRUT). To this end, measures of effectiveness, 
efficiency and user satisfaction, such as ease of use and completion of task in a timely manner were captured 
during the usability testing. Satisfaction and user confidence was assessed using the System Usability Scale (SUS) 
satisfaction questionnaire and the post-task Confidence rating question. 
 
The design is based upon an explicit understanding of users, tasks and environments. Medlnformatix considers 
the context always - the exam room, the patient interaction, the difference scenarios faced both by the clinician 
and the back office or front desk staff- when designing and enhancing the software. Context was carefully 
considered in the User Centered Design testing, and Medlnformatix observes users in the field on a regular 
basis. 
 
Users are involved throughout design and development of the process, in initial needs assessment, 
conceptualization and specifications. Medlnformatix solicits user feedback early in the process using a Client 
Advisory Board, User Group Meetings, contact with individual clients, client visits, and industry trade shows and 
events. Users are involved throughout, through prototyping and beta-testing, then after release through 
enhancement requests. 
 
Agile development allows Medlnformatix to make changes throughout the process making it iterative. 
 

METHOD 
 
PARTICIPANTS 
 
 
A total of 10 participants were tested on MedInformatix EHR V7.7. Participants in the test were physicians, 
nurses, and other healthcare assistants in ambulatory and radiology settings, ranging in years of experience 
with MedInformatix (MI).  MedInformatix Product Team analysts coordinated the recruitment of participants.  
 
For the test purposes, end-user characteristics were identified and translated into recruitment screener used 
to solicit potential participants; an example of a screener is provided in Appendix 1 – Sample Participant 
Recruitment screener. The recruiting process for participants identified known MedInformatix users of various 
geographic areas and demographics, targeting a cross-section of the population based on diversification of job 
role and length of experience with MedInformatix. The participants were contacted and scheduled via email, or 
telephone and confirmed for their testing session. 
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Participants had no direct connection to the development organization producing the MedInformatix EHR 
system. Participants were not from the testing or supplier organization. For new features being tested, each 
participant was given a 30-minute online training session prior to the study. This training was specifically 
developed and designed to introduce the MedInformatix EHR V7.7 technology, features and benefits being 
tested during this study. 
 
 
 
The following Table 1: Participants lists participants by characteristics, including demographics, professional 
experience, computing experience, product experience and user needs for assistive technology. Participant 
names were replaced with Participant IDs so that an individual’s data cannot be tied back to individual 
identities. 

 
   
 

Table 1: Participants  
 

  
Part 
ID 

  
Gender 

 

Age 

 

Education 

 
Occupation/ role 

 
Professional 
Experience 
(months) 

 
Computer 
Experience 
(months) 

 
Product 
Experience 
(months) 

Assistive 
Technology 

Needs 

1 ID01 F 30-39 Master’s 
Degree 

Nurse Practitioner 156 252 36 No 

2 ID02 F 30-39 Associate 
Degree 

Operations Manager 156 204 120 No 

3 ID03 F 30-39 Associate 
Degree 

Nurse 168 200 168 No 

4 ID04 F 50-59 Doctorate 
Degree 

Physician 252 240 194 No 

5 ID07 F 40-49 Bachelor’s 
Degree 

Network 
Administrator 

288 312 216 No 

6 ID08 F 50-59 Associate 
Degree 

Tech Manager 432 240 240 No 

7 ID13 F 40-49 Associate 
Degree 

Surgical Coordinator 180 120 120 No 

8 ID16 M 40-49 Associate 
Degree 

Medical Assistant 300 324 66 No 

9 ID18 F 50-59 Master’s 
Degree 

Chief Administrative 
Officer 

420 360 168 No 

10 ID19 M 30-39 Trade technical 
vocational 

training 

Assistant Director of 
Nursing 

192 204 192 No 

 

 
10 participants (matching the demographics in the section on Participants) were recruited and 10 participated in 
the usability test. 0 participants failed to show for the study. 
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Participants were scheduled for 60-minute sessions with 30 minutes prior to each session for debrief by the 
administrator(s)/data logger(s), and to provide a demo of new functionality. A spreadsheet was used to keep 
track of the participant schedule and included each participant’s demographic characteristics as provided by the 
recruiting team. 
 
Those who responded to the invitation to take part in the study were sent documentation ahead of time with 
participants instructions(tasks), and a questionnaire that served as the participant screener. 
 
 
Summary of Participant Characteristics: 

 
Participants had experience with the occupation and expertise that aligns with the capability under testing. The 
users selected as participants was varied and was not limited to clinicians. The demographic characteristics of 
the test participant reflected the audience of current and future users. 
 
 
Table 2: Summary of Participants 
 

Gender  
Female 8 
Male 2 
  
Age Range  
30 to 39 4 
40 to 49 3 
50 to 59 3 
  
Education  
Some college credit, no degree 0 
Trade technical vocational training 1 
Associate degree 5 
Bachelor’s degree 1 
Master’s degree 2 
Doctorate degree 1 
  
Years of Experience with EHRUT  
None 0 
Up to 3 years 0 
3 - 5 years 1 
5 – 10 years 3 
10 – 15 years 2 
15 – 20 years 4 
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STUDY DESIGN 
 

Overall, the objective of this test was to discover areas where the MedInformatix EHR application performed 
well – that is, effectively, efficiently, and with satisfaction – and areas where it did not meet the needs of the 
users.  The data from this test may serve as a baseline for future tests of updated versions of MedInformatix 
EHR and/or for comparison with other EHRs provided the same tasks are used. In short, this testing serves as 
both a means to record or benchmark current usability, but also to identify areas where improvements must  
be made. 
 
During the usability test, each participant interacted with MedInformatix EHR V7.7. Each participant used the 
system and was provided with the same instructions during individual 60-90-minute GoToMeeting sessions. 
 
MedInformatix EHR V7.7 was evaluated for effectiveness, efficiency and satisfaction as defined by measures 
collected and analyzed for each participant: 
 

• Number of tasks successfully completed within the allotted time without assistance 
• Time to complete the tasks 
• Number and types of errors 
• Path deviations 
• Participant’s verbalizations (comments) 
• Participant’s satisfaction ratings of the system 

 
Additional information about the various measures can be found in the Usability Metrics section of this report. 
 

 

TASKS 
 

Eighteen (18) tasks were constructed that would be realistic and representative of the kinds of activities a user 
might perform with MedInformatix EHR V7.7. The tasks were selected based on four ONC CEHRT2015 
certification criteria, taking into consideration their frequency of use, criticality of function, potential for risk to 
patient safety, and those that may be most troublesome for users.  For Task risk ranking see Table 3. The Safety-
Enhanced Design [SED] tasks for the four ONC CEHRT2015 certification criteria included: 
 
Clinical Decision Support 170.315.a.9 
 

1. Add, trigger and review a CDS intervention and/or reference resource for Problem List note  
2. Add, trigger and review a CDS intervention and/or reference resource for Medication List  
3. Add, trigger and review a CDS intervention and/or reference resource for Medication Allergy List 
4. Add, trigger and review a CDS intervention and/or reference resource for at least one Demographic 
5. Add, trigger and review a CDS intervention and/or reference resource for Laboratory Test 
6. Add, trigger and review a CDS intervention and/or reference resource for Vital Signs 
7. Add, trigger and review a CDS intervention and/or reference resource for a combination of at least 2 of 

the prior elements (Problem list, Medication list, Medication Allergy List etc.) 
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Implantable Device List 170.315.a.14 
 

8. Record UDI  
9. Access UDI, device description, identifiers, and attributes  
10. Change UDI Status  

 
 
e-Prescribing 170.315.b.3 
 

11. Create, Change and review Fill status 
12. Create, Cancel and review Fill Status  
13. Create, Refill and review Fill Status 
14. Request and Receive medication history information 

 
 
IMO 170.315.a.6 
 

15. Access the Problem List  
16. Record a new Problem  
17. Change an existing Problem  
18. View the Full List of Problem(s)  

 
 
A summary of the User Tasks prioritization ranking based on the Risk associated with user errors is shown in 
Table 3. 
 
 
Table 3: Task Risk Ranking Pre-& Post test 
 

Measure/Task Risk Pre-Reason for Risk Post Risk Observations  
Clinical Decision Support 
170.315.a.9 

   

Add, trigger and review a CDS 
intervention and/or reference 
resource for Problem List note 

7 This module is in regular use and as such low risk. No error observed during testing. 

Add, trigger and review a CDS 
intervention and/or reference 
resource for Medication List 

7 This module is in regular use and as such low risk. No error observed during testing. 

Add, trigger and review a CDS 
intervention and/or reference 
resource for Medication Allergy 
List 

7 This module is in regular use and as such low risk. No error observed during testing. 

Add, trigger and review a CDS 
intervention and/or reference 
resource for at least one 
Demographic 

7 This module is in regular use and as such low risk. No error observed during testing. 

Add, trigger and review a CDS 
intervention and/or reference 
resource for Laboratory Test 

7 This module is in regular use and as such low risk. No error observed during testing. 

Add, trigger and review a CDS 
intervention and/or reference 
resource for Vital Signs 

7 This module is in regular use and as such low risk. No error observed during testing. 
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Add, trigger and review a CDS 
intervention and/or reference 
resource for a combination of at 
least 2 of the prior elements 
(Problem list, Medication list, 
Medication Allergy List etc.) 

7 This module is in regular use and as such low risk. No error observed during testing. 

Implantable Device List 
170.315.a.14 

   

Record UDI  2 This module is new to clients, recording of UDI can 
present human error into the record keeping as 
current version does not have a scanner recorder 
  
  

This module is new and relies heavily on 
users recording the information by hand.  
There is the possibility that patients will not 
have the right information to provide EP 
with gaps potentially existing in the medical 
record.  Foreknowledge of what is needed 
and expected is helpful to ensure 
compliance.   With this being the case, no 
error observed during testing.  

Access UDI, device description, 
identifiers, and attributes  

2 Same as above. Same as above. 

Change UDI Status  2 Same as above. Same as above. 

e-Prescribing 
170.315.b.3 

   

Create, Change and review Fill 
status 

5 User could match to the wrong record when 
information is too similar. 

No error observed during testing. 

Create, Cancel and review Fill 
Status  

5 User could potential cancel the wrong medication. No error observed during testing. 

Create, Refill and review Fill 
Status 

7 This module is in regular use. No error observed during testing. 

Request and Receive medication 
history information 

7 Third party provided information to end user, end-user 
verbally confirm  

No error observed during testing. 

IMO 170.315.a.6    
Access the Problem List  7 Very Low risk because of low probability of human 

error 
No error observed during testing. 

Record a new Problem  6 Users are required to use SNOMED Clinical Language, 
this a change in behavior which was driven by billing 
terminology. 

No error observed during testing. 

Change an existing Problem  7 Very Low risk because of low probability of human 
error 

No error observed during testing. 

View the Full List of Problem(s) 7 Very Low risk because of low probability of human 
error 

No error observed during testing. 

    
Risk Probability Key    
1 - Very High Risk  Note: Users usage did not demonstrate an increase in potential risk to patients. 

 
2 - High Risk     
3 - Moderate-High Risk    
4 - Moderate Risk     
5 - Moderate-Low Risk   

 
 

6 - Low Risk     
7 - Very Low Risk     

 
 
 
 



Version 7.7 
 

Page 11 of 37 

F    
 
 
 
 

11 | EHR Usability Test Report of MedInformatix EHR V7.7 
 

 
PROCEDURES 

 
Upon starting the remote connection, GoToMeeting session, the participant was greeted; their identity was 
verified and matched with a name on the participant schedule. Each participant read and agreed to a recording 
consent and signed a non-disclosure agreement and informed consent form (See Appendix 3). The administrator 
from the test team witnessed the participant’s acknowledgement and acceptance. Some sessions were 
recorded for quality purposes and analysis. 
 
The usability testing administrators who conducted the tests were experienced Information Technology and 
Health Information Specialists with 5-15 years of experience with EHRUT, backgrounds in healthcare, health 
information technology and clinical EHR training, implementation and support. 
 
The administrator moderated the session including administering instructions and tasks. The administrator also 
monitored task times, obtained post-task rating data, and took notes on participant comments. They also served 
as the data logger and took notes on task success, path deviations, number and type of errors. 

 

Participants were instructed to perform the tasks (see specific instructions below): 

• As quickly as possible making as few errors and deviations as possible. 
• Without assistance; administrators could give immaterial guidance and clarification on tasks, but not 

instructions on use. 
• Withholding questions until the end of the test. 

 
For each task, the participants were given a written copy of the task. Task timing began once the administrator 
finished reading the question and indicated to start. The task time was stopped once the participant said, 
“Done,” or otherwise indicated they had successfully completed the task. Scoring is discussed below in the Data 
Scoring section. 
 
Following the session, the administrator gave the participant the post-test questionnaire (e.g., the System 
Usability Scale, see Appendix 5), and thanked them for their participation.  
 
Participants' demographic information, task success rate, time on task, errors, deviations, verbal responses, and 
post-test questionnaire were recorded into a spreadsheet. 
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TEST LOCATION 
 

All participants were tested on the MedInformatix EHR V7.7 system during remote 
conferencing sessions using GoToMeeting. The test participants used their own computer terminals that could 
connect to the Internet with a GoToMeeting session. Participants were located at their place of employment, to 
ensure maximum comfort in their usual work environment. The environment was verified as comfortable for 
users, noise levels were kept to a minimum with the ambient temperature within a normal range. 
 
During a given GoToMeeting session, only the test administrator and participant communicated with one 
another. The GoToMeeting usability test session was conducted by a test administrator from MedInformatix 
Product team working from their office or a small conference room. The test administrator accessed and 
observed the completion of tasks via remote access to the participants terminal.  During a session, only the test 
administrator could see the participant’s screen and hear the participant’s comments, questions, and responses. 
 

 

TEST ENVIRONMENT 
The EHRUT would typically be used in an ambulatory healthcare setting. In this instance, testing of the 
MedInformatix EHR V7.7 system was conducted via remote connection during individual GoToMeeting sessions. 
Each participant was sent a GoToMeeting invitation for their specific testing session.  

 

For testing, the computer used a Windows 2016 Data Center running OS 64-bit Intel ® Xeon ® 2.4 GHZ. The 
MedInformatix EHR V7.7 application was set up by the vendor according to MedInformatix documentation 
describing the system set-up and preparation. The application itself ran on a client/server platform using a 
sample test database set up specifically for the test on a WAN connection. Participants used their keyboard and 
mouse when interacting with the EHRUT and logged in directly to the application to perform the tasks. The 
application was set to default system preferences. 

Technically, the system performance (i.e., response time) was representative to what actual users would 
experience in a field implementation. Additionally, participants did not change any of the default system 
settings (such as control of font size). 
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TEST FORMS AND TOOLS 

 
During the usability test, various documents and instruments were used, including: 

• Participant Recruiting Screener 

• Recording Consent Form 

• Informed Consent 

• Facilitator’s Guide 

• Task Confidence Questionnaire 

• Post-test Questionnaire 

• Tasks 

• Datalogger Spreadsheet 

Examples of these documents can be found in Appendices 1-6 respectively. Participants’ interaction with 
MedInformatix EHR V7.7 was captured and recorded digitally using GoToMeeting software running on the test 
administrator’s workstation. Verbal responses were recorded through GoToMeeting recording software 
(microphone integrated into the participant’s computer or through a telephone connection).  

The participant’s interaction with the EHRUT was captured and recorded digitally with screen capture software 
running on the administrator’s machine.  

 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 



Version 7.7 
 

Page 14 of 37 

F    
 
 
 
 

14 | EHR Usability Test Report of MedInformatix EHR V7.7 
 

PARTICIPANT INSTRUCTIONS 
 

The administrator reads the following instructions aloud to the participant (also see the full 
facilitator’s guide in Appendix [4]. 

Thank you for participating in this study. Our session today will last 60-90 minutes. During that time, you will 
look at MedInformatix V7.7 electronic health record system. 

I will ask you to complete a few tasks using this system and answer some questions. We are interested in how 
easy (or how difficult) this system is to use, what in it would be useful to you, and how we could improve it. You 
will be asked to complete these tasks on your own trying to do them as quickly as possible with the fewest 
possible errors or deviations. Do not do anything more than asked. If you get lost or have difficulty, I will provide 
minimal assistance with anything to do with the system itself. Please save your detailed comments until the end 
of a task or the end of the session when we can discuss freely. I did not have any involvement in its creation, so 
please be honest with your opinions.  

The product you will be using today is currently in development. Some of the screens or functionality may or may 
not be new to you. 

We are recording the audio and screenshots of our session today. All the information that you provide will be 
kept confidential and your name will not be associated with your comments at any time. Should you feel it 
necessary you are able to withdraw at any time during the testing. 

Do you have any questions or concerns? 

Following the procedural instructions, participants were shown the EHR and as their first task, were given time 
(5 minutes) to ask questions and/or make comments. Once this task was complete, the administrator gave the 
following instructions: 

For each task, I will read the description to you and say “Begin.” At that point, please perform the task and say “Done” once 
you believe you have successfully completed the task. I would like to request that you not talk aloud or verbalize while you are 
doing the task.  I will ask you your impressions about the task once you are done. 

Participants were then given 18 tasks to complete. Tasks are listed in the facilitator’s guide in Appendix [4]. 
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USABILITY METRICS 

According to the NIST Guide to the Processes Approach for Improving the Usability of Electronic Health Records, 
EHRs should support a process that provides a high level of usability for all users. The goal is for users to interact 
with the system effectively, efficiently, and with an acceptable level of satisfaction. To this end, metrics for 
effectiveness, efficiency and user satisfaction were captured during the usability testing. 

 

The goals of the test were to assess: 

 

1. Effectiveness of MedInformatix EHR V7.7 by measuring participant success rates and errors 

2. Efficiency of MedInformatix EHR V7.7 by measuring the average task time and path deviations 

3. Satisfaction with MedInformatix EHR V7.7 by measuring ease of use ratings 

 

 

DATA SCORING 
 

The following table (Table 4) details how tasks were scored, errors evaluated, and the time data 

analyzed. 

   Table 4. Details of how observed data were scored. 

Measures Rationale and Scoring 
Effectiveness: 

Task Success 
Task success was determined by assigning numeric weights for various levels of task success, 
as follows: 
• Easy -Pass (without assistance) = 5  
• Medium -Partial success (minimal assistance) = 3 
• Hard – Partial Success took longer than expected) = 1 
• Fail – Failure (gave up or failed) = 0 

 

The results are provided as a percentage 

Effectiveness: 

Task Failures 

If the participant abandoned the task, did not reach the correct answer or performed it 
incorrectly, or reached the end of the allotted time before successful completion, the task 
was counted as a “Fail.” No task times were taken for errors. 

Note: Not all deviations would be counted as errors 
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Efficiency: 

Task Deviations 

The participant’s navigation path (i.e., steps) through the application was recorded. 
Deviations occur if the participant, for example, went to a wrong screen, clicked on an 
incorrect menu item, followed an incorrect link, or interacted incorrectly with an on-screen 
control. This path was compared to the optimal path. The number of steps in the observed 
path is divided by the number of optimal steps to provide a ratio of path deviation. 
Path deviations are reported on a qualitative level for use in recommendations for 
improvement. 

Efficiency: 
Task Time 

Each task was timed from when the administrator said “Begin” until the participant said, 
“Done.” If he or she failed to say “Done,” the time was stopped when the participant 
stopped performing the task. Only task times for tasks that were successfully completed 
were included in the average task time analysis. Average time per task was calculated for 
each task. Variance measures (standard deviation and standard error) were also calculated. 

Satisfaction: 
 
 
Task Rating 
 
 
 
Task Confidence 
 
 
 
System Satisfaction 

Participant’s subjective impression of the ease of use of the application was measured by 
administering a simple post-task question, a post-task confidence question as well as a 
post-session questionnaire. After each task, the participant was asked to rate “How 
confident/easy was it to use the product being tested to complete the given task: on a 
scale of 1 (Very Difficult) to 5 (Very Easy).” These data are averaged across participants. 

Common convention is that average ratings for systems judged easy to use should be 3.3 
or above. 

To measure participants’ confidence in and likeability of MedInformatix EHR V7.7 overall, 
the testing team administered the System Usability Scale (SUS) post-test questionnaire.  
Questions included, “I think I would like to use this system frequently,” “I thought the 
system was easy to use,” and “I would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire in Appendix 5 – System 
Usability Scale Questionnaire. 
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RESULTS 
 
DATA ANALYSIS AND REPORTING 

 

The results of the usability test were calculated according to the methods specified in the Usability Metrics 
section above.  
The usability testing results for MedInformatix EHR V7.7 are detailed in the sections below (see Table 5). The 
results should be seen considering the objectives and goals outlined in Study Design section. The data yielded 
actionable results that, if corrected, yield material, positive impact on user performance.   

Table 5: Testing Results 

Measure 

 
Task 

 
 

N 

Task 
Success 
% 

Path Deviation          
# of steps 

Task Time - Secs Errors Task Rating 
Avg 5=Easy 

 
# 

Mean SD  Obs./Opt. SD Mean  SD Optimal Mean SD Mean (SD) 

  

SD 

 

 

1. A.9 Add, trigger and review a CDS 
intervention and/or reference resource 
for Problem List note 

10 100 0 4/4 0 48 8 42 0 0 4.9 0.3 

2. A.9 Add, trigger and review a CDS 
intervention and/or reference resource 
for Medication List 

10 100 0 5/5 0 71 13 68 0 0 4.9 0.3 

3. A.9 Add, trigger and review a CDS 
intervention and/or reference resource 
for Medication Allergy List 

10 100 0 4/4 0 33 17 25 0 0 4.9 0.3 

4. A.9 Add, trigger and review a CDS 
intervention and/or reference resource 
for at least one Demographic 

10 100 0 3/3 0 57 16 49 0 0 5.0 0 

5. A.9 Add, trigger and review a CDS 
intervention and/or reference resource 
for Laboratory Test 

10 100 0 4/4 0 53 16 46 0 0 4.9 0.3 

6. A.9 Add, trigger and review a CDS 
intervention and/or reference resource 
for Vital Signs 

10 100 0 3/3 0 53 12 52 0 0 5.0 0 

7. A.9 Add, trigger and review a CDS 
intervention and/or reference resource 
for a combination of at least 2 of the 
prior elements (Problem list, 
Medication list, Medication Allergy List 

 

10 100 0 3/3 0 54 9 51 0 0 5.0 0 

8. A.14 Record UDI 10 96 0.6 6/5 0.3 10 10 7 0 0 4.8 0.6 
9. A.14 Access UDI, device description, 

identifiers, and attributes 
10 100 0 5/5 0 29 9 25 0 0 4.7 0.5 

10. A.14 Change UDI Status 10 88 0.9 7/4 0.5 21 14 14 0 0 4.7 0.5 

11. B.3 Create, Change and review Fill 
status. 

10 88 0.9 19/16 0.5 105 22 88 0 0 4.3 0.6 

12. B.3 Create, Cancel and review Fill Status 10 96 0.6 11/10 0.3 60 18 50 0 0 4.9 0.3 
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13. B.3 Create, Refill and review Fill Status 10 96 0.6 16/15 0.3 76 21 66 0 0 4.7 0.5 
14. B.3 Request and Receive medication 

history information 
10 100 0 9/9 0 55 14 46 0 0 5.0 0 

15. A.6 Access the Problem List 10 100 0 3/3 0 9 4 8 0 0 5.0 0 
16. A.6 Record a new Problem 10 100 0 3/3 0 24 7 21 0 0 5.0 0 
17. A.6 Change an existing Problem 10 100 0 3/3 0 11 4 10 0 0 5.0 0 
18. A.6 View the Full List of Problem(s) 10 100 0 1/1 0 5 2 5 0 0 5.0 0 

 

The results from the System Usability Scale (SUS) scored the subjective satisfaction with the system based on 
performance with these tasks to be: 91.0 %.  Broadly interpreted, scores under 60 represent systems with 
poor usability; scores over 80 would be considered above average. Table 5 indicates participant performance in 
the MedInformatix EHR V 7.7 usability test was quite satisfactory. The overall average task completion rate was 
98%. The following charts show details of task performance, task completion, users’ self-rated confidence level 
in using the EHRUT, time spent per task and finally the system satisfaction rating. 
 
Chart 1. Task Performance – Shows the % distribution of scored criteria per task 
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Chart 1: Task Performance
TASK 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21
1-word CDS1 CDS2 CDS3 CDS4 CDS5 CDS6 CDS7 UDI 1 UDI 2 UDI 3 e-Rx 1e-Rx 2e-Rx 3e-Rx 4IMO 1 IMO 2 IMO 3 IMO 4
Easy 10 10 10 10 10 10 10 9 10 7 7 9 9 10 10 10 10 10
Medium 1 3 3 1 1
Hard
Fail
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Chart 2. Task Completion – Shows the basic proportion of Successful Tasks / Total Tasks Performed 

 

                                                                          (Binomial distribution - All levels categorized as Pass/Fail) 
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Chart 3. Task Completion & Confidence - Shows the basic proportion of Successful Tasks / Total Tasks 

Performed for each task including Users’ Self-Reported Confidence Ratings re: their successful completion 

of each task 

 

             

Data Chart 3: Task Completion & User Confidence Ratings (Non-adjusted) 
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1-word CDS1 CDS2 CDS3 CDS4 CDS5 CDS6 CDS7 UDI 1 UDI 2 UDI 3 e-Rx 1e-Rx 2e-Rx 3e-Rx 4IMO 1 IMO 2 IMO 3 IMO 4
Successful 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
Conf Rating 0.99 0.99 0.99 1 0.99 1 1 0.97 0.96 0.96 0.9 0.99 0.96 1 1 1 1 1
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Chart 4. Time Spent/Task (Mean w/ Max & Min) 

 

 

Data Chart 4: Time per Task 
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Chart 5. Satisfaction (System Usability Scale) 

 

SUS Histogram 

    SUS Histogram Tally (read only) 
  Item# 1 2 3 4 5 N 
  1 0 0 0 3 7 10 
  2 7 3 0 0 0 10 
  3 0 0 0 3 7 10 
  4 9 1 0 0 0 10 
  5 0 0 0 6 4 10 
  6 8 1 1 0 0 10 
  7 0 1 0 2 7 10 
  8 8 1 0 1 0 10 
  9 0 0 0 2 8 10 
  10 7 0 3 0 0 10 

 

  

91.0 % SUS Score

System Usability Scale Histogram

1 2 3 4 5

I think I would like to use this software product frequently. ||| ||||
|||

I found the product unnecessarily complex. ||||
|||

|||

I thought the product was easy to use. ||| ||||
|||

I think I would need Tech Support to be able to use this product. ||||
||||
|

|

I found the various functions in this product were well integrated. ||||
||

||||

I thought there was too much inconsistency in this product. ||||
||||

| |

I imagine that most people would learn to use this product very quickly. | || ||||
|||

I found the product very cumbersome to use. ||||
||||

| |

I felt very confident using this product. || ||||
||||

I need to learn a lot about this product before I could effectively use it. ||||
|||

|||

Strongly
Disagree

Strongly
Agree
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DISCUSSION OF THE FINDINGS 
 
In general, the participants performed very well and were satisfied with MedInformatix EHR V7.7 system. Some 
were very impressed with the new features and the improvements from previous version and stated that they 
couldn’t wait to move to this version. Participants expressed that the solution had a very good flow and was 
very easy and useful. They loved the new criteria and found it very useful to doctors. There were a few 
participants that had trouble with some parts of a few tasks (took longer time to complete) but in general they 
were able to successfully complete all the tasks with little or no difficulty. Participants performed all tasks on 
their own with no assistance. They were given a demo of new features at the beginning of the test; no external 
documentation was provided. The average performance rate and overall participant satisfaction rates were 
very high. The MedInformatix EHR V7.7 system appears to be a highly usable EHR. Below are the individual 
criteria test findings. 
 
Analysis of the Use, Tested Performance, and Error Rates 
 
Based on the analysis of the data and the observed performance of the participants during testing we did not 
identify any risk prone errors – with a potential likelihood of occurrence and adverse consequences to patients. 
Please see Table 3 For the perceived risk analysis and the post risk results. 
 
Clinical Decision Support 170.315.a.9 
 

1. Add, trigger and review a CDS intervention and/or reference resource for Problem List note  
2. Add, trigger and review a CDS intervention and/or reference resource for Medication List  
3. Add, trigger and review a CDS intervention and/or reference resource for Medication Allergy List 
4. Add, trigger and review a CDS intervention and/or reference resource for at least one Demographic 
5. Add, trigger and review a CDS intervention and/or reference resource for Laboratory Test 
6. Add, trigger and review a CDS intervention and/or reference resource for Vital Signs 
7. Add, trigger and review a CDS intervention and/or reference resource for a combination of at least 2 of 

the prior elements (Problem list, Medication list, Medication Allergy List etc.) 
 

EFFECTIVENESS 
 
The success score for Clinical Decision Support was 100%. The participants were able to successfully add, trigger 

and review a CDS intervention and/or reference resource for Problem list, Medication List, Medication Allergy 

list, Demographic, Laboratory Test, Vital Signs and a combination. Participants were very effective. The system 

functionality appears to be effectively designed and configured. Based on the success observed the screens 

required for activating and triggering the CDS are effectively designed.  
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EFFICIENCY 
Based on the observation of the task time, users were able to quickly activate and Trigger the CDS data. Most of 

the participants outdid the optimal time while performing the tasks, and completed the tasks within the optimal 

number steps, as suggested by the number of steps taken by expert users. No deviations were observed. 
 

SATISFACTION 
 
Based on the task ratings and SUS results data, users appear to be satisfied with the design and found the 

interaction to be uncomplicated and easy to complete. End-users appear to be satisfied with the ability to 

activate the CDS and how it was returning relevant results based on Age, Sex, and Clinical relevant data.  The 

participants were familiar with these tasks and gave an average satisfaction rate of 4.94 out of 5 points.  

 
MAJOR FINDINGS 
 

• Selecting/Activating the CDS followed standard protocol and was easy for users to complete. 
• User found the CDS improved over initial impression from MU2. 
• Triggering the CDS is an automatic process and provided no difficulties for the end-users. 
• Review the results was simple and straight forward 

 
Based on the success, failure and path deviation data, the design of the Clinical Decision Support functionality 
appears to be effectively designed and configured. Users could easily add, trigger and review a CDS intervention 
and/or reference. Overall all our participants found these tasks to be easy, effective and had a high confidence 
rating. Participants indicated that the design was much improved from the previous version. Some indicated 
that their use of CDS was minimal but with this new design they would consider incorporating it into their 
workflow. Participants indicated that the process wasn’t hard, but it involved more clicks that what they would 
prefer. Participants that hadn’t been using the solution and were not familiar with the workflow found it simple 
to follow and use. Information presented in the CDS seemed very accurate better than before. 
 
AREAS FOR IMPROVEMENT 
 

• No major areas of improvements in enabling or triggering the CDS were found 
• Some users would like the CDS findings moved which is a superficial change, to reduce clicks. 
• Consider button placement for accessing the CDS directly.  
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Implantable Device List 170.315.a.14 
 

1. Record UDI  
2. Access UDI, device description, identifiers, and attributes  
3. Change UDI Status  

 

EFFECTIVENESS 
The average success score for Implantable Device List tasks was 94.6%. Based on the success observed the 

screens required for accessing, recording and updating Unique Device Identifier (UDI) content is effectively 

designed.  Participants were very effective.  
 
EFFICIENCY 
 

Based on the observation of the task time, users were able to quickly activate access, record and update UDI 

records.   Most of the participants outdid the optimal time while performing the tasks, and completed the tasks 

within the optimal number steps, as suggested by the number of steps taken by expert users. We observed 

some minor deviations as some participants weren’t familiar with the workflow and took a little bit longer time 

than the optimal to complete the task. Others couldn’t clearly find where the activation button was, so it took 

some time to find it on the screen. Overall even with the minor deviations the mean time was close to the 

optimal time. 
 

SATISFACTION 
 
Based on the task ratings and SUS results data, users appear to be satisfied with the design and found the 

interaction to be uncomplicated and easy to complete.  The participants were not as familiar with these tasks 

but still gave an average satisfaction rate of 4.73 out of 5 points. 

 
 
MAJOR FINDINGS 
 

• Users found the user interface tidy and easy to use to record Implantable device. 
• User express concern with manually entering the UDI number. 
• Users that deviated recovered quickly with error message that don’t require a click to close out, 

appreciated this interface change. 
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Based on the success, failure and path deviation data, the design of the Implantable Device list functionality 
appears to be effectively designed and configured. Users could easily record and access the UDI, device 
description, identifiers, and attributes. Users had a little more trouble changing the UDI status due to not 
being familiar with the new screen. Overall all our participants found these tasks to be easy, effective and 
had a high confidence rating. Some users deviated but were able to complete the task without increasing 
overall time to complete the task.  

 

AREAS FOR IMPROVEMENT 
• Users express interest in improving task 3 which could use cosmetic improvement to aid users through 

the select. 
• Add an inactive button or make the active checkbox bigger easier to find. 
• Look for ways so end-user doesn’t need to manually enter the UDI number, like reading from the c-CDA  
• Add a scanner option 

 

e-Prescribing 170.315.b.3 
 
For the Electronic Prescribing criteria our participants engaged in the following tasks: 
 
1. Create, Change and review Fill status 
2. Create, Cancel and review Fill Status  
3. Create, Refill and review Fill Status 
4. Request and Receive medication history information 

 
The above tasks were staged (simulated) strictly for UCD testing only. The simulation was performed in a single 
round trip using the NIST test tool to complete the desired workflow and not just a single task. 
 

EFFECTIVENESS 
The average success score for e-Prescribing tasks was 95%. Based on the success, the screens required to 

perform these tasks are effectively designed for easy use as commented by the end-users.    
 
EFFICIENCY 
Based on the observation of the task time, users were able to quickly complete the tasks. Users were surprise by 

the ease of use for both cancelling a prescription and the importing medication history directly off the 

internet.  Most of the participants performed the tasks within or a little outside the optimal time while 

performing the tasks. We observed some minor deviations as 3 of the 4 tasks are new to the end-user.  
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SATISFACTION 
 
Based on the task ratings and SUS results data, users appear to be satisfied with the design and found the 

interaction to be uncomplicated and easy to complete.  The participants were not as familiar with these tasks 

but still gave an average satisfaction rate of 4.73 out of 5 points. 

 
MAJOR FINDINGS 
 
• Users find this workflow comparable to current renewal workflow so learning curve is low and satisfactory.  
• Deviations are expected as 3 workflows are new to users. 
• Users find the Cancel prescription a game changer and a potential time saver.  
• Users expressed interest in starting to use Pharmacy direct history. 
• User are excited for the workflow change to aid in improving communication with the Pharmacy.  

 
Based on the success, failure and path deviation data, the design of the e-Prescribing functionality appears to be 
effectively designed and configured. Users loved the prescription history solution. Users experienced some 
minor deviations as this was the first time they had seen the workflow and the new screens but were able to 
complete the task without increasing overall time to complete the task. Overall all our participants loved this 
functionality and found the tasks to be very easy, effective and had a high confidence rating. Users didn’t 
experience any errors during testing.  In routing a change request user had a small area for properly selecting a 
drug they want the area to expand to the whole row. Users are excited for the workflow change to aid in 
improving communication with the Pharmacy. Here are some participants verbalization of the experience with 
e-Prescribing: 

• Very easy to use. No changes needed. 
• Can’t wait to use it. I like it. It’s a great improvement. 
• Excited to have this functionality. 
• Very comfortable with the workflow. 
• It was intuitive, flow made sense. It’s pretty simple. 

 

AREAS FOR IMPROVEMENT 
 

• Medication streamlining can still be improved based on customer feedback, eliminating clicks down the 
line can still be seen and was so noted.   

• Most users wanted the whole row for selection instead of a small area to trigger a selection. 
• Refill should update patient chart or somehow record the refill. 
• Add a button to top navigation to stop at the Rx Pharmacy. 
• Add a confirmation message that the cancellation was completed successfully. 
• Some users express better training prior to usage but could see that the tools will improve as adoption 

is from Fax to Electronic workflow will improve effectiveness and efficiency.  
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Problem List – IMO 170.315.a.6 
For the Problem List criteria our participants engaged in the following tasks: 

 
1. Access the Problem List  
2. Record a new Problem  
3. Change an existing Problem  
4. View the Full List of Problem(s)  

 
This criterion was completed twice as MedInformatix provides users with two distinct user interfaces one which 
starts with ICD10 and then is mapped to SNOMED.  While this test was using the IMO interface to record 
SNOMED which are then mapped to ICD10. 

 

EFFECTIVENESS 
 
Based on the success observed the screens required for accessing, recording and updating Problem List content 
is effectively designed. The success score for Problem List tasks using IMO search was 100%. 
 

EFFICIENCY 
 
Based on the observation of the task time, users were able to quickly activate access, record and update the 
Problem List with ease and efficiency. No deviations were observed. 
 

SATISFACTION 
 
Based on the task ratings and SUS results data, users appear to be satisfied with the design and found the 

interaction to be uncomplicated and easy to complete. The participants were familiar with these tasks and gave 

an average satisfaction rate of 5 out of 5 points.  
 
 
MAJOR FINDINGS 
 

• Users found it easy to find SNOMED selection and not worry about matching to an ICD10 selection. 
• User scores are higher here than in Phase 2 UCD testing.  
• User were more vocal in the usage and flexibility to insert SNOMED finding it easier and appreciated not 

having to manually map from ICD10 to SNOMED. 
• Many express this workflow more favorable to our prior screen selection of ICD10 and then SNOMED mapped 

selection. 
 
Based on the success, failure and path deviation data, the design of the Problem list with IMO search 
functionality appears to be effectively designed and configured. Users could easily record and change a new 
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problem. Overall all our participants found these tasks to be easy, effective and had a high confidence rating. No 
deviations were observed. Some participants verbal comments were: 

• Love this functionality 
• This will be helpful for the doctors entering diagnosis because they know the terminology not the codes. 
• Like that you can search for words and then refine your search. 
• Easy to use and straightforward. 
• There’s a lot of information on the screen and I really like it. It’s great! 
• Like where you can search very definitive and see what you can choose. 
• Very accessible and easy and helpful to us. Will use it often. 
• Functionality much improved from prior version. 

 
AREAS FOR IMPROVEMENT 
 

• Users did not comment in how to improve the workflow. 
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APPENDICES 
 

Appendix 1: SAMPLE PARTICIPANT RECRUITING SCREENER 
 

At the beginning of each usability test session, the test administrator asked participants the questions on the recruiting 
screener and recorded the responses. 

Participant Questionnaire 
 

1. Date of Testing ____________________ 

2. Participant ID____________________________________________________________ 

3. Description of Intended Users _______________________________________________ 

4. Participant Gender________________________________________________________ 

5. Participant Age___________________________________________________________ 

6. Participant Education______________________________________________________ 

7. Participant Occupation/Role_________________________________________________ 

8. Participant Professional Experience___________________________________________ 

9. Participant Computer Experience_____________________________________________ 

10. Participant Product Experience ______________________________________________ 

11. Does the Participant have any Assistive Technology Needs________________________ 
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Appendix 2: PARTICIPANT DEMOGRAPHICS 
 

Gender  

Female 8 
Male 2 
  
Age Range  
30 to 39 4 
40 to 49 3 
50 to 59 3 
  
Education  
Some college credit, no degree 0 
Trade technical vocational training 1 
Associate degree 5 
Bachelor’s degree 1 
Master’s degree 2 
Doctorate degree 1 
  
Years of Experience with EHRUT  
None 0 
Up to 3 years 0 
3 - 5 years 1 
5 – 10 years 3 
10 – 15 years 2 
15 – 20 years 4 
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Appendix 3: NON-DISCLOSURE AGREEMENT AND INFORMED CONSENT FORM 

NON-DISCLOSURE AGREEMENT AND INFORMED CONSENT FORM  
  

Non-Disclosure Agreement THIS AGREEMENT is entered as of _ _, 2018, between (“the 
Participant”) and the testing organization MedInformatix, Inc. located at Address.  
  
The Participant acknowledges his or her voluntary participation in today’s usability 
study may bring the Participant into possession of Confidential Information. The term 
"Confidential Information" means all technical and commercial information of a 
proprietary or confidential nature which is disclosed by MedInformatix, or otherwise 
acquired by the Participant, during today’s study.  
  
By way of illustration, but not limitation, Confidential Information includes trade 
secrets, processes, formulae, data, know-how, products, designs, drawings, computer 
aided design files and other computer files, computer software, ideas, improvements, 
inventions, training methods and materials, marketing techniques, plans, strategies, 
budgets, financial information, or forecasts.  
  
Any information the Participant acquires relating to this product during this study is 
confidential and proprietary to MedInformatix and is being disclosed solely for the 
purposes of the Participant’s participation in today’s usability study. By signing this 
form, the Participant acknowledges that s/he will not disclose this confidential 
information obtained today to anyone else or any other organizations.  
  
Participant’s printed name:      
  
 
 
Signature:    Date:     
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Appendix 4: EXAMPLE FACILITATOR’S GUIDE 

FACILITATOR’S GUIDE 
Before Recording: 

Thank you for agreeing to participate in this usability study. Our session will last 60-90 minutes. Today you will 

be helping us evaluate workflows pertaining to the 2015 ONC's EHR Vendor Certification requirements. In a 

moment I will be asking you to complete these workflows using MedInformatix EHR V 7.7. I'll be taking notes.  

You have been provided a Participant Guide. This information is available for reference only. I will talk you 

through each step of the process and then ask all the questions. After I have asked the question, you may refer 

to the Participant Guide for more detail. You will be asked to complete these tasks on your own trying to do 

them as quickly as possible with the fewest possible errors or deviations. Do not do anything more than asked. 

Also, I want you to hold your questions, until the end since the tasks are being timed. I would ask to please be 

honest with your opinions. Do you have any questions regarding the documentation provided? 

<Facilitator: If you determine that the Participants questions should be part of the recorded session please have 

them ask it again during the recording. Answer questions and start appropriate demos (PHR etc.).> Before we 

get started I would like to record this session to help me later with my report. Therefore, to help with this data 

collection, we are seeking your verbal consent to record the session <Show consent form> 

Begin Recording: 

<Ask them to please read out loud "I understand that my usability test session will be recorded. I grant 

MedInformatix, Inc. permission to use this recording for internal use only, for improving the products being 

tested." from the consent form.> 

What you will be looking at today is MedInformatix EHR V7.7 populated with a mock patient's information. I will 

ask you to complete a few tasks using this system and answer some questions. please keep in mind that the 

data may not be clinically accurate, and we understand that it may not be applicable to your specialty. We are 

interested in how easy (or how difficult) this system is to use, what in it would be useful to you, and how we 

could improve it.  

I will ask you to start when I say, "BEGIN NOW", and please tell me when you think you've completed the task by 

saying “DONE”. If you feel lost or have difficulty completing the scenario, please continue to try as best as you 

can. If you are unable to complete the task, we will stop the task and move you on to the next task. At the end 

of the session, I will ask you additional questions and there will be a survey. Please understand, we are 

evaluating the ease of use on the software and not your performance on this system.  

 Do you have any questions or concerns? 
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Prior to beginning test – administrator must: 
1. Use the datalogger spreadsheet to record the participant’s experience. 

a. Find the participants identification number and fill out the chart information 
b. Time each task from when the administrator said “Begin” until the participant said, “Done.” Include only 

task times for tasks that were successfully completed in the average task time analysis 
c. Record how many times a task was completed successfully and how many times it was attempted.  
d. Record the path that a participant used to complete the task (count the clicks). Record the difference and 

ratio of the observed path to the optimal path 
e. Record the difference and ratio of the observed time and the optimal time 
f. Count the total number of failed attempts to complete the task (errors), and divide by the total number of 

times that task was attempted 
g. Record task score – Easy – Medium – Hard - Fail 

<BEGIN TEST> 

 
 

 UCD Phase 3 Tasks 
 

Clinical Decision Support 170.315.a.9 
 

Task 1 – Instruct participant to start the first task, following the ‘A9. Participant Instructions’ document: 
- Problem List Interventions and Identify User Diagnostic and Therapeutic Reference Information 
- Optimal path: Select Patient> Enter DX of DM and Chronic Kidney Disease Stage 4> Navigate 

to CDS Report window. 
- Optimal Time: 42 s 

At the end of this task ask the participant the post-task Confidence rating question.  

Task 2 - Instruct the participant to start the second task, following the ‘A9. Participant Instructions’ document: 
- Medication List Interventions and Identify User Diagnostic and Therapeutic Reference Information 
- Optimal path: Select Patient> Enter DX Hypertensive heart and Reason for caring puerperium> Enter 

RX Nicardipine 30 MG and 24 hr. Nisoldipine 20 MG> Enter Vitals Ht. 110 inches, Wt. 68 Ibs.> 
Navigate to CDS Report window  

- Optimal Time: 68 s  

At the end of this task ask the participant the post-task Confidence rating question.  

Task 3 - Instruct the participant to start the third task, following the ‘A9. Participant Instructions’ document. 
- Medication Allergy List Interventions and Identify User Diagnostic and Therapeutic Reference 

Information 
- Optimal path: Select Patient> Enter Allergy NSAID> Enter RX add Aspirin> Navigate to CDS Report 

window.  
-  Optimal Time: 25 s  

      At the end of this task ask the participant the post-task Confidence rating question. 
 

Task 4 - Instruct the participant to start the third task, following the ‘A9. Participant Instructions’ document. 
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- Demographics Interventions and Identify User Diagnostic and Therapeutic Reference Information 
- Optimal path: Select Patient> Enter Demographics age of patient 1935> Navigate to CDS Report 

window  
- Optimal Time: 49 s  

      At the end of this task ask the participant the post-task Confidence rating question. 

Task 5 - Instruct the participant to start the third task, following the ‘A9. Participant Instructions’ document. 
- Lab Tests and Results Interventions and Identify User Diagnostic and Therapeutic Reference 

Information 
- Optimal path: Select Patient> Enter Labs> add results for Potassium SerPL-sCnc equal to  2 mEq/L> 

Navigate to CDS Report window.  
- Optimal Time: 46 s  

      At the end of this task ask the participant the post-task Confidence rating question. 
 

Task 6 - Instruct the participant to start the third task, following the ‘A9. Participant Instructions’ document. 
- Vital Signs Interventions and Identify User Diagnostic and Therapeutic Reference Information 
- Optimal path: Select Patient> Enter Vitals BP 180/90> Navigate to CDS Report window.  
-  Optimal Time: 52 s  

      At the end of this task ask the participant the post-task Confidence rating question. 
 

Task 7 - Instruct the participant to start the third task, following the ‘A9. Participant Instructions’ document. 
- Combo Intervention and Identify User Diagnostic and Therapeutic Reference Information 
- Optimal path: Select Patient> Enter DX Essential Hypertension> Enter RX Amlodipine 2.5 MG/ 

atorvastatin 10 MG and Verapamil 120 
-  Optimal Time: 51 s  

      At the end of this task ask the participant the post-task Confidence rating question. 
 

 
 
 
 
 
Criteria – Implantable Device List 170.315.a.14 
 

Task 1 – Instruct participant to start the first task, following the ‘A14. Participant Instructions’ document: 
- “In the system, select Jane Doe and access the Implantable Device List.” 
- Optimal Path: Patient List > Enter patient > Chart Icon > Navigate tree links to Implantable device> 

open link 
- Optimal Time: 7 s  

 
At the end of this task ask the participant the post-task Confidence rating question.  

Task 2 - Instruct the participant to start the second task, following the ‘A14. Participant Instructions’ document: 
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- From the previous task, press add, perform search, select, add UDI and save. 
- Enter the following code: 
- (01)10884521062856(11)141231(17)150707(10)A213B1(21)1234 
- Confirm entry 
- Optimal Path: Press add> Perform search> Select entry> Add UDI > Save 
- Optimal Time: 25 s  

At the end of this task ask the participant the post-task Confidence rating question.  

Task 3 - Instruct the participant to start the third task, following the ‘A14. Participant Instructions’ document: 
- From the previous screen, double click on entry, uncheck active, update, to see full list uncheck 

show active only 
- Optimal Path: Double click on entry> Uncheck active> Update> Uncheck show active only 
- Optimal Time: 14 s 

At the end of this task ask the participant the post-task Confidence rating question.  

Criteria – e-Prescribing 170.315.b.3 
Story Line –  
BOBZIMBABWAYALPHAPAINUBERDOOBERNAME (Patient 12) is coming with his mother to 
HoitzThisIsAReallyLongLastNameABCDE (Provider 10) office. Mother starts explaining that last night her son was 
complaining of a sore throat but without cough. He hardly could eat or drink because of the painful swallowing. 
This morning he woke up with headache and nausea. When she measured his temperature, it was 102.2F. She 
immediately gave him acetaminophen syrup, which briefly lowered his temperature to 99.5F. He refused to eat 
or drink and started vomiting. Shortly after that his temperature rose again. The doctor examines the patient 
and notices that his throat is red, and tonsils are swollen with white exudate on the tonsils. The doctor performs 
a rapid strep test, which shows presents of streptococcal infection. He diagnoses the patient with 
pharyngotonsillitis. Due to the patient's severe symptoms, doctor decides to give him amoxicillin oral 
suspension, 45mg/kg/day. Since patient's weight is 18kg, doctor prescribes amoxicillin oral suspension 
400mg/5mL, bottle size 100mL (MU2-17). The doctor instructs mother to give her son 5mL every 12h for ten 
days. He also gives her instructions for fever management, fluid and food intake and probiotic use. After 
receiving the prescription, 10Dot6 Pharmacy Store1 MU Long Name (Pharmacy 7) sends the doctor a change 
request, asking for authorization to change amoxicillin due to patient's history of penicillin allergy. Based on 
guidelines recommendation, the pharmacist is proposing azithromycin oral suspension, 12mg/kg/day. According 
to patient weight, pharmacist calculates dosage and suggests azithromycin oral suspension 200mg/5mL, bottle 
size 30mL (MU2-18), with directions for patient to take 5.4mL once a day 2 hours after meal for five days. After 
thoroughly review of the pharmacy change request, the doctor approves the change. The pharmacy sends RxFill 
notification, informing the doctor that patient picked up medication same morning they received prescription.  

 
Task 1 – Instruct participant to start the first task, following the ‘B3. Participant Instructions’ document: 

- Write a RX for amoxicillin oral suspension 400mg/5mL, bottle size 100mL with instructions for 5mL every 
12h for ten days. 

- Send to 10Dot6 Pharmacy Store1 MU Long Name  
- Pause test 
- Notified that Pharmacy has pending changes 
- Review changes and confirm 
- Pause Test 
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- Review chart for Fill notification 
- Optimal Path: Select Patient> Chart> RX> Add> Save> Print/Route> Exit> Views> RX Change 

View> Match> Respond to Pharmacy> Selection> Save> Chart> RX> Right click on MED for 
Electronic Prescription Information 

- Optimal Time:  88 s 

At the end of this task ask the participant the post-task Confidence rating question.  

Story Line –  
Susanne Adirondack (Patient 6), with a diagnosis of hypertension is coming to see Doctor Anna Bates 
(Provider 1) for a checkup. Susanne Adirondack has been taking medication for hypertension for two years, 
and her blood pressure was well controlled. Since first being diagnosed with hypertension Susanne has been 
measuring her blood pressure regularly. In the last few weeks she has noticed some deviations in her blood 
pressure that are not responding to the therapy. Doctor Anna Bates examines Susanne and concludes that 
her blood pressure is elevated, even with the medication therapy. She also notices that the patient's legs 
are a little swollen. Doctor Anna Bates decides to prescribe Hydrochlorothiazide 50mg (MU2-01), one tablet 
every morning, and sends a prescription to the NYC Pharmacy 10.6MU (Pharmacy 4). The doctor instructs 
Susanne Adirondack to take medication and to keep track of her blood pressure as usual. After reviewing 
the patient's information and the medication order more closely, Doctor Anna Bates decides that she 
prescribed too high a dose of hydrochlorothiazide and sends the pharmacy a cancel request for the 
prescription. The pharmacy recognizes the patient and cancels the order for the Hydrochlorothiazide 50mg 
tablets. 
Task 2 – Instruct participant to start the second task, following the ‘B3. Participant Instructions’ document: 

- Write a RX for Hydrochlorothiazide 50mg instructions one tablet every morning. 
- Send to NYC Pharmacy 10.6MU 
- Pause test 
- Cancel RX 
- Pause Test 
- Review chart for confirmation 
- Optimal Path: Select Patient> Chart> RX> Add> Save> Print/Route> Stop Meds> Check in 

Cancel at Pharmacy> Uncheck active only> Right click on Medication for Electronic Prescription 
Information 

- Optimal Time:  50 s 

At the end of this task ask the participant the post-task Confidence rating question.  
 

Story Line –  
John Yosemite (Patient 2) has been smoking one pack of cigarettes per day for 30 years. A year ago, he has started 
experiencing fatigue, persistent productive cough and shortness of breath on exertion. He visited pulmonologist Stuart 
Ivy (Provider 6), who diagnosed him with COPD (chronic obstructive pulmonary disease). Constant exposure to the 
cigarette smoke damaged John's lungs and led to development of COPD stage 2, with FEV1/FVC < 0.7 and FEV1=75%. 
For symptoms relief, pulmonologist prescribed Serevent, 1 inhalation twice a day, and Atrovent HFA (MU2-09), 2 
inhalations four times a day with possibility to take additional inhalation if symptoms persist during the day (maximum 
12 puffs in any 24-hours period). After a year being on this treatment, patient's symptoms are well under control and 
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he is feeling good. He also stopped smoking, as advised. Since John Yosemite has run out of Atrovent HFA, he orders 
three additional refills from 10Dot6 Pharmacy Store1 MU Long Name (Pharmacy 7). The pharmacist sends a refill 
request to the pulmonologist. The pulmonologist approves only one refill, to cover the patient's needs until his 
upcoming provider visit. 

Task 3 – Instruct participant to start the third task, following the ‘B3. Participant Instructions’ document: 
- Write a RX for Atrovent HFA with instructions for 2 inhalations four times a day with possibility to 

take additional inhalation if symptoms persist during the day (maximum 12 puffs in any 24-
hours period) and 11 refills 

- Send to 10Dot6 Pharmacy Store1 MU Long Name  
- Pause test 
- Notified that Pharmacy has refills waiting 
- Review changes and confirm refill approval. 
- Optimal Path: Select Patient> Chart> RX> Add> Save> Print/Route> Exit> Views> RX Renewal 

View> Match> Accept> Save> Chart> RX> Right click on MED for Electronic Prescription 
Information 

- Optimal Time:  66 s 

At the end of this task ask the participant the post-task Confidence rating question.  

 
Story Line –  
Susanne Adirondack (Patient 6) has been experiencing strong abdominal pain for two days. Since the pain is getting 
worse, she decides to visit her primary care physician Anna Bates (Provider 1). At the examination, Dr. Anna Bates 
notices in Susanne's electronic health record that she is on treatment for osteoporosis and glaucoma. She also notices 
that specialist recently changed Susanne's therapy for osteoporosis. To get a complete picture of the patient's 
medications, Dr. Anna Bates orders medication history for 12 months period from CA Pharmacy 10.6MU (Pharmacy 1)  
 
Task 4 – Instruct participant to start the third task, following the ‘B3. Participant Instructions’ document: 

- Review Prescription drug history 
- Import one medication 
- Optimal Path: Select Patient> Chart> RX> PharmacyRXHist> Request History> Okay box> Add 

Medication to History from list> Add details as needed> Save Medication> 
- Optimal Time:  46 s 

At the end of this task ask the participant the post-task Confidence rating question.  

Problem List – IMO 170.315.a.6 
 
Task 1 – Instruct participant to start the first task, following the ‘A6. Participant Instructions’ document: 

- “In the system, select Jane Doe and confirm the Problem list has active data: 
- Confirm this is an Active Problem 
- Chronic headache disorder SNOMED code: 431237007” 
- Optimal Path: Patient List > Chart> DX>  
- Optimal Time: 8 s 

At the end of this task ask the participant the post-task Confidence rating question.  
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Task 2 – Instruct participant to start the second task, following the ‘A6. Participant Instructions’ document: 
- Change a problem on the problem list 
- “In the system enter Portal hypertension (disorder); SNOMED code: 34742003.  
- Optimal Path: Add via Search IMO> Search DX> Save 
- Optimal Time: 21 s 

At the end of this task ask the participant the post-task Confidence rating question. 

Task 3 – Instruct participant to start the third task, following the ‘A6. Participant Instructions’ document: 
- “In the system Update problem list with Chronic headache disorder is improving “ 
- Optimal Path: Change Status> Improving> Save  
- Optimal Time: 10 s 

At the end of this task ask the participant the post-task Confidence rating question.  

Task 4 – Instruct participant to start the fourth task, following the ‘A6. Participant Instructions’ document: 
- “In the system Show the resolved item when accessing the full list.  Confirm Juvenile acne SNOMED Code: 

238743000 is present. “ 
- Optimal Path: Check in show resolved 
- Optimal Time: 5 s 

At the end of this task ask the participant the post-task Confidence rating question.  
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Appendix 5: SYSTEM USABILITY SCALE QUESTIONNAIRE 

 
 

 
Participant ID#:______ 
 
These questions will be asked at the end of the testing read and familiarize yourself with them  
 
 
 
                                                               Difficult                                                                                                                Easy  

Overall this task was 
 

                                                            1                 2                3                 4                 5                6                 7                                                          
 
 

 
 
 
 

1. I think that I would like to use 
this system frequently. 

 
2. I found the system unnecessarily 

complex. 
 

3. I thought the system was easy 
to use. 

 
 

4. I think that I would need the 
support of a technical person to 
be able to use this system.  

 
5. I found the various functions 

in this system were well 
integrated.  

 
6. I thought there was too much 

inconsistency in this system.  
 
 

7. I would imagine that most people 
would learn to use this system 
very quickly. 

 
8. I found the system very 

cumbersome to use. 
 
 

9. I felt very confident using the 
system.  

 
10. I needed to learn a lot of 

things before I could get going 
with this system.  

 

Strongly Strongly 
disagree agree 
 
 
 

1 2 3 4 5 
 
 
 

1 2 3 4 5 
 
 
 

1 2 3 4 5 
 
 
 

1 2 3 4 5 
 
 
 
 

1 2 3 4 5 
 
 
 
 
 
1 2 3 4 5 
 
 

 
 

1 2 3 4 5 
 
 

 
1 2 3 4 5 
 
 

 
 
1 2 3 4 5 
 
 

 
 
1 2 3 4 5
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Appendix 6:  RECORD CONSENT FORM 
 

Recording Consent Form 
 

Thank you for participating in our Usability Client Design Testing. 
We will be recording your session to allow MedInformatix, Inc. staff 
members who are unable to be present today to observe your session and 
benefit from your comments. 
 
Please read the statement below and verbally indicate you accept and 
consent. 
 
 
I understand that my usability test session will be recorded. 
I grant MedInformatix, Inc. permission to use this recording for internal use 
only, for improving the products being tested. 
 
Signature               __________________________________________ 
 
Print Name            __________________________________________ 
 
Date Signed           

__________________________________________ 
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